MAS 90

Installation and System Administrator's Guide
Contents

Chapter 1 — Introduction 1
How to Use This Manual 1
  Graphic Conventions 1
  Text Conventions 2

Chapter 2 — Getting Started 3
Overview of System Startup 3
  Installing in the Windows Environment 3
Installation Process 4
  Installing MAS 90 5
  Running the MAS 90 Setup Program 7
Reinstalling 16
  Selecting Installation Options 16
Workstation Setup 18
  Running Workstation Setup 18
Microsoft Internet Explorer 24
  Installing Internet Explorer 24
Microsoft Data Access Components (MDAC) 27
  Installing MDAC 27
  Installing DCOM 29

Chapter 3 — Consideration for Installing on a Novell NetWare Network 31

Chapter 4 — Consideration for Installing on a Windows NT/2000/2003 Server Network 33

Chapter 5 — Consideration for Installing on a Windows Peer-to-Peer Network 35

Chapter 6 — Installing Crystal Reports 37
Crystal Reports Overview 37
  Installing the Design Environment 37
  Installing Crystal Reports to the Workstation 38

Chapter 7 — Installing the PCCharge Payment Server 41
PCCharge Payment Server 41
  Installing the Payment Server 41
  Accessing the Payment Server Manual 44
  Support and Upgrades 44
Chapter 8 — Performing System Startup  45
Starting the Software with No Security  46
  Edit Default User Settings  47
Starting the Software with Standard Security  48
  Performing Administrative Tasks  49
Creating and Activating Companies  50
  Company Activation  50
  Copying a Company  53
Migrating Level 3.x Data  54
  Verifying Data  55
  Migrating Data  55
Converting Data Files to the Current Level  66
  Convert Data Files  66
Setting Up Roles and Users for Security  68
  Defining Roles  68
  Creating Users and Assigning Roles  73
Setting Additional User Preferences for Security  76
  Setting a Workstation to Automatically Log Off  76
  Locking Users  78
Setting System Preferences  79
  Requiring a Logon and Password  79
Setting Accounting Date Preferences  83
  Setting a Prompt for the Accounting Date  83
  Setting the Accounting Date from the System Date  84
  Restricting the Accounting Date to Current and One Future Period  85
Changing Your Administrator Password  86

Chapter 9 — System Administrator Tasks  87
Determining Who is Accessing the System/Modules  87
Creating Public Tasks  88
Modifying Company Preferences  90
Uninstalling Modules  91

Appendix A — Checklists  93
Pre-Installation Checklist  93
Post-Installation Checklist  96
Appendix B — Converting MAS 90 Crystal Reports from a Prior Version  101

Appendix C — Overview of Application Startup  107

Accounts Payable  108
   Data You Need  108
   Conversion Process  108
Accounts Receivable  111
   Data You Need  111
   Conversion Process  111
Bank Reconciliation  114
   Conversion Process  114
Bar Code  115
   Data You Need  115
Bill of Materials  115
   Data You Need  115
   Conversion Process  116
e-Business Manager  117
   Data You Need  117
General Ledger  117
Inventory Management  118
   Data You Need  118
   Conversion Process  118
Job Cost  120
   Data You Need  120
   Conversion Process  120
Magnetic Media Reporting  122
   Data You Need  122
Material Requirements Planning  123
   Data You Need  123
Payroll  123
   Data You Need  123
   Converting at the Beginning of the Calendar Year  124
   Converting in the Middle of the Calendar Year  124
Purchase Order  126
   Data You Need  126
   Conversion Process  126
Contents

Sales Order 128
  Data You Need 128
  Conversion Process 128

Work Order 130
  Data You Need 130
  Conversion Process 131
Chapter 1

Introduction

How to Use This Manual

This manual provides the information necessary for installing MAS 90. This manual also contains information and troubleshooting tips on the configuration of the various operating systems and environments in which the MAS 90 software is supported. It is designed to function as a self-teaching guide. The instructions contain detailed technical information on the configuration of operating systems and environments.

For a complete listing of operating system requirements, see the Supported Platform Matrix which can be found in the Support area of the Best Software Web site (www.bestsoftware.com).

Graphic Conventions

The following icons are used throughout this manual to indicate different types of information.

- The **NOTE** symbol is followed by additional information about a topic.

- The **WARNING** symbol is followed by information to help you avoid costly mistakes.
Chapter 1  Introduction

Text Conventions

The following table describes the text conventions used in this manual.

<table>
<thead>
<tr>
<th>Text Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menus</td>
<td>Menus are shown in this format: Select menu &gt; menu task name.</td>
</tr>
<tr>
<td></td>
<td><strong>Examples:</strong></td>
</tr>
<tr>
<td></td>
<td>• Select File &gt; Change Company.</td>
</tr>
<tr>
<td></td>
<td>• Select General Ledger Budget menu &gt; Budget Maintenance.</td>
</tr>
<tr>
<td><strong>Bold</strong> font</td>
<td>Indicates text entered at a field or text selected at a field.</td>
</tr>
<tr>
<td></td>
<td><strong>Examples:</strong></td>
</tr>
<tr>
<td></td>
<td>• At the Value field, type a search value, such as 01, for the lookup.</td>
</tr>
<tr>
<td></td>
<td>• In the Filter window, to delete a filter, select &lt;none&gt; at a filter’s Column field.</td>
</tr>
<tr>
<td><strong>Italic</strong> font</td>
<td>Indicates references to other manuals.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
</tr>
<tr>
<td></td>
<td>• For more information, refer to your Getting Started Guide.</td>
</tr>
</tbody>
</table>
Chapter 2

Getting Started

Overview of System Startup

Before you can install MAS 90 System Setup, Library Master, and any of the MAS 90 modules, your hardware must be properly configured, and the appropriate operating system software must be fully installed and operational. In addition, you should also calculate the total disk storage requirements for each module to be installed.

Installing in the Windows Environment

The following installation procedures address the Windows® environments. For information on the specific operating system requirements, see the Supported Platform Matrix in the Support area of the Best Software Web site.

After you have verified the compatibility of your hardware and operating system software, you must verify the available hard disk storage space before proceeding with the installation process. To do this, calculate the total disk storage requirements for each module to be installed. This calculation ensures that your hard disk contains adequate space to accommodate your processing requirements. System Setup and Library Master require approximately 150 MB of hard disk space. Each module occupies approximately 15 to 25 MB of hard disk space. An additional 400 MB of disk space is required to install the Crystal Reports Designer.

NOTE
Prior to beginning the installation process, see Pre-Installation Checklist on page 93.
Chapter 2  Getting Started

Installation Process

Before performing a new installation, read this guide completely before setting up MAS 90. Each module has a setup options window that allows you to customize MAS 90 for your specific needs. Taking the time to understand all the options available before you install and set up your modules allows you to use your accounting software to its fullest potential.

You must run the MAS 90 Setup program to perform a new MAS 90 installation, to upgrade your system from Level 3.x, and to re-install over an existing Version 4 installation. The InstallShield wizard guides you through the installation. The options on the wizard may vary depending on your installation option.

A series of procedures must be completed for new installations. If you are upgrading your software from Level 3.x, you must follow additional procedures after installing MAS 90 to migrate your existing data and convert it to the current level.

Follow these procedures to perform a new installation, upgrade your system from Level 3.x, or install over an existing Version 4 installation.

1  Run the MAS 90 Setup program (see Running the MAS 90 Setup Program on page 7).

2  If you are upgrading your system from Level 3.x, perform the following:
   • Migrating Level 3.x Data on page 54
   • Converting Data Files to the Current Level on page 66

3  Install Crystal Reports (this is optional).

4  Set up and activate the module files for your companies, create roles, create user codes, and set up system preferences (see Performing System Startup on page 45).

5  If you are converting your existing business management system to MAS 90, assemble the data you need to set up each module (see Overview of Application Startup on page 107).
Installing MAS 90

To begin the MAS 90 installation

1. Start Windows; if you are installing MAS 90 to a server, map a drive letter to that server or install at the server.

2. Close all other programs.

3. Place the MAS 90 CD-ROM in the CD-ROM drive of the workstation or server to which you are installing MAS 90.

4. If Autorun is enabled on the workstation, the MAS 90 Autorun screen appears; otherwise, select Start > Run and type D:\AUTORUN.EXE, where D:\ is the CD-ROM drive.
There are several options available on the MAS 90 Autorun screen for installing MAS 90 components.

- **Install MAS 90**: Click this option to install the MAS 90 Setup program. This option is required.

- **Run Workstation Setup**: Click this option to install the Workstation Setup program to local workstations. Workstation Setup can also be run from the MAS 90 installation. This option is required for all workstations.

- **Install Web Engine**: Click this option to install the Web Engine. This option requires the e-Business Manager module.

- **Install Microsoft Internet Explorer**: Click this option to install Microsoft Internet Explorer, which is required to access reports through the Business Insights Desktop module.

- **Install Microsoft Data Access Components (MDAC)**: Click this option to install Microsoft's ODBC drivers.

- **Install Acrobat Reader**: Click this option to install Adobe's Acrobat Reader. Acrobat Reader is required to view the online *Getting Started Guide* and module report samples in the Help system.

\[NOTE\]

For information on installing the Web Engine, refer to your e-Business Manager Installation Guide.
Running the MAS 90 Setup Program

To run the MAS 90 Setup program

1. On the MAS 90 Autorun screen, click Install MAS 90. The Setup program may take a few seconds to launch. Click Next.

2. If you do not have Internet Explorer or the Microsoft Data Access Components (MDAC) installed, the Missing Prerequisites window appears. Clicking Next in the Missing Prerequisites window returns you to the Autorun screen, where you can install the needed prerequisites.

For more information, see Microsoft Internet Explorer on page 24 and Microsoft Data Access Components (MDAC) on page 27.
3 Click I Accept to accept the terms of the license agreement. You must accept the agreement to continue with the installation.
4  The Setup program requires you to specify where to install MAS 90. Click Browse to view a listing of all drives and directories available on the server. You are prompted to create the path if the path you enter does not exist.

If you are upgrading your system from Level 3.x, you cannot perform an in-place installation over your Level 3.x data. You must first install the current Version 4 software to a new location and then migrate and convert your Level 3.x data to Version 4.

After selecting a path, click Next.
5 Type the company and registration information found on your packing list to register your software.

You can access most modules for 45 days before you must register them; however, the e-Business Manager, Custom Office, Magnetic Media, and Visual Integrator modules must be registered before they can be accessed.

**NOTE**

If your serial number includes leading zeros, make sure to enter all zeros.

The serial number, user key, customer number, and product key are required.
Select a security model for the system. If you select the No Security option, all users will be able to access all modules and menu tasks until security is enabled at a later time. If you select Standard Security, you will set up companies, roles, user information, and system configuration after installing the software. Standard Security requires users to log on to the system.

**NOTE**
After security is enabled, it cannot be disabled.

If you select the Standard Security option, create an administrator password. You will need this password to enter the system, create companies, set up roles, users and system preferences.
Chapter 2  Getting Started

7 Modules that have been purchased are automatically selected. Clear the check box of each applicable module that you do not want installed. The time required for installing modules depends on the number of modules installed. If several modules are installed, this process can take several minutes. Click Next.

![MAS 90 Select Components](image)

7 WARNING
Do not integrate your existing modules with nonregistered modules unless you plan to purchase those modules.

8 You can install modules that you have not purchased; however, you are required to purchase and unlock these modules after 45 days. The 45-day trial period does not begin until the first time a module is accessed. Click Yes to change any of your module selections. Click No to continue with the installation process.

![Question](image)

12  MAS 90 Installation and System Administrator's Guide
9 A program group and icon are established in the Start menu to run MAS 90. Modify this folder, if needed, and click Next.
Chapter 2  Getting Started

10  Review your settings and click Next to begin the installation.

The Setup program verifies that no other programs are running that may be using files to be installed by the Setup program. If you receive a message (after clicking Next) stating that Setup cannot copy files because they are currently in use, close all programs and click the Continue option, and then click Next. To exit the Setup program, click the Exit option, and click Next.

If you receive a message (at the end of the installation) stating that Setup was unable to detect an installation of Adobe Acrobat Reader, click OK to continue with the installation. After the installation process, the Autorun screen appears. You can install Acrobat Reader from this window. Acrobat Reader is needed to view the online Getting Started Guide and module report samples in the Help system.
If you are performing a new installation or installing over an existing Version 4 installation, your installation is complete. Click Finish.

If you have Level 3.x data to migrate to this installation, use the Migrate Level 3 Data task on the Library Master Utilities menu. For more information, see Migrating Level 3.x Data on page 54.
Reinstalling

If you previously installed a 4.x version of the software, the following window appears after the Welcome page. You can install over an existing Version 4 installation, or install a new copy of the software. Installing over an existing 4.x version of the software streamlines the installation process.

Selecting Installation Options

1. Select an installation option

   - If you are installing over an existing Version 4.x installation, select the previously installed version of the software that you will install over and click Next. Proceed to step 2 on page 17.

   - If you are installing a new copy of the software, select Install a new copy of this product and click Next. Proceed to step 1 on page 7.
2 After selecting an existing Version 4 installation to install over, you are asked to add, reinstall, or uninstall all modules.

- Select Add if you purchased additional modules and are adding them. You will be required to enter a new product key.

- Select Reinstall to reinstall previously installed modules. The product key information from the selected installation is used unless the information is invalid or has expired. You will not be able to enter new product key information using this option.

- Select Uninstall to completely uninstall MAS 90. To uninstall modules individually, use the System Configuration task on the Library Master Setup menu.

To reinstall over an existing Version 4 installation, select Reinstall and then click Next. Proceed to step 7 on page 12.
Chapter 2  Getting Started

Workstation Setup

The Workstation Setup program is used specifically for Windows workstations attached to a Novell or Windows network. This program must be run in order to use MAS 90 software on any workstation. The workstation from which the MAS 90 software was originally installed does not need to run this Setup. The Workstation Setup program copies all the necessary Dynamic Link Libraries and programs to the Windows\System directory and also sets up the initialization files for this particular workstation.

For workstation operating system requirements, see the Supported Platform Matrix in the Support area of the Best Software Web site.

Running Workstation Setup

To run Workstation Setup

1. Close all other programs before beginning the installation process.
2. To begin the installation process from the CD-ROM, map a drive letter to the share point above the MAS90 directory on the server on which MAS 90 is installed. Place the MAS 90 CD-ROM in the CD-ROM drive of your workstation.

To begin the installation process from a server installation of MAS 90, map a drive letter to the share point above the MAS90 directory. In the MAS90\Wksetup directory, double-click AUTORUN.EXE to begin the installation.

NOTE
Best Software does not support running MAS 90 through a shared network installation of Windows.

WARNING
The Workstation Setup program will not run if it is not executed from a mapped or physical drive letter. Do not run the Workstation Setup program from a UNC path or through Network Neighborhood.
If Autorun is enabled on the workstation, the MAS 90 Autorun screen appears; otherwise, select Start > Run and type `D:\AUTORUN.EXE`, where `D:\` is the CD-ROM drive. On the MAS 90 Autorun screen, click Run Workstation Setup. The Workstation Setup program takes a few seconds to launch.

**NOTE**
Run the Workstation Setup program after every MAS 90 software upgrade.
4 Click Next to proceed with the installation.

5 If you do not have Internet Explorer or the Microsoft Data Access Components (MDAC) installed, the Missing Prerequisites window appears. Clicking Next in the Missing Prerequisites window returns you to the Autorun screen, where you can install the needed prerequisites.

For more information, see Microsoft Internet Explorer on page 24 and Microsoft Data Access Components (MDAC) on page 27.
6 Select the Folder where MAS 90 is installed. Click Browse to select the MAS90 folder. After selecting a path, click Next.

If you are running the Workstation Setup program from the MAS90\Wksetup directory, the MAS90 path will automatically display in the Destination Folder.
A program group and icon are established in the Start menu to run MAS 90. Modify this folder, if needed, and click Next.
8 Click Install to begin the installation.

If you receive a message (after clicking Install) stating that Setup was unable to detect an installation of Adobe Acrobat Reader, click OK to continue with the installation. After the installation process, the Autorun screen appears. You can install Acrobat Reader from this window. Acrobat Reader is needed to view the online *Getting Started Guide* and module report samples in the Help system.

After the Workstation Setup program has copied the necessary files to your workstation, a program group is created and an icon is added to the Start menu to run MAS 90.
Microsoft Internet Explorer

Microsoft Internet Explorer is an HTML viewer that is used throughout MAS 90 to enhance the product. Business Insights Dashboard generates templates and customized pages of data with graphs and charts that can be displayed through Internet Explorer. Web Services within MAS 90 link directly with Internet Explorer and the Internet allowing you to track packages, get map directions, or visit the Best Software Web site. In addition, you can link directly to your customer or vendor Web sites within MAS 90. Microsoft Internet Explorer is provided as a convenience on the MAS 90 CD-ROM so that you do not have to download the content from an FTP site over the Internet (which can take several hours over a dial-up connection).

MAS 90 requires Internet Explorer 5.0 or later. You do not need to install this version of Internet Explorer if you already have a version of 5.0 or later installed.

Installing Internet Explorer

To install Internet Explorer

1. In the MAS 90 Autorun screen, click Install Microsoft Internet Explorer.

2. Accept the Licensing Agreement with Microsoft to use Internet Explorer.
3 For most users, selecting the Install Now option is sufficient. This option installs all the core components of Internet Explorer and other Internet tools. The Customize your browser option is available for advanced users who want to install specific or additional components not included in the default installation option. Select an option and click Next.
4 If you selected the Customize your browser option, the following window appears.

![Image of the Component Options window]

The drop-down list box allows you to select one of three preconfigured options: Minimum, Typical, and Full. You can then select or clear options from the tree view depending on what you want installed on your workstation. Installing everything requires approximately 50 MB of hard drive space. Only the browser component is required for MAS 90 operation. Click Next.

5 After installing Internet Explorer, you may be required to reboot your workstation.
Microsoft Data Access Components (MDAC)

Microsoft Data Access Components (MDAC) provides the connectivity layer between databases and applications. All third-party applications that use ODBC to connect to MAS 90 data sources must have MDAC installed.

Installing MDAC

To install MDAC:

1. Place the MAS 90 CD-ROM in the CD-ROM drive of the workstation from which you are installing. If Autorun is enabled on the workstation, the MAS 90 Autorun screen appears; otherwise, select Start > Run and type D:\AUTORUN.EXE, where D:\ is the CD-ROM drive.

2. Click Install Microsoft Data Access Components.

3. If you attempt to install MDAC from the MAS 90 Autorun screen, but you are not running Windows 98 Second Edition, an error message dialog box appears.

   Only Windows 98 Second Edition may require DCOM to be installed before installing MDAC (recent operating systems include MDAC). Do not attempt to install DCOM on any other operating system.

   The Data Access Components may not be able to install if there are open programs that are using components of the Data Access Pack. Close all external programs before running the Data Access Pack installation.
Chapter 2  Getting Started

4  Select the check box to accept the terms of the license agreement, then click Next.

5  Click Next to begin the installation process.

6  The Data Access Components copies files to your system. When complete, the Data Access Pack Setup program informs you that it has successfully completed the installation and exits.

7  After installing MDAC, you need to reboot your system for the changes to take place.
Installing DCOM

DCOM for Windows 98 Second Edition is included on the MAS 90 CD-ROM and is copied to the Workstation Setup (WKSETUP) directory when the Server component is installed.

To install DCOM

1. Open the Windows Explorer and change directories to MAS90\WKSETUP\DATAACC\DCOM.

2. Double-click the DCOM98.EXE file to start the installation.

3. After completing the DCOM installation, re-run the MDAC installation routine, which can be found in the MAS90\WKSETUP\DATAACC directory called MDAC_TYP.EXE. These files can also be downloaded from the Microsoft Web site.
Chapter 3

Consideration for Installing on a Novell NetWare Network

The following are special considerations to be aware of before installing or upgrading MAS 90 on a Novell NetWare network.

- All users exit MAS 90 before performing an upgrade.
- MAS 90 users need full rights to all the files and folders below the MAS90 folder, including read, write, create, erase, modify, and file scan. Not granting these rights will result in errors when using MAS 90.
- Long file name support must be enabled on the server.
- For a list of the supported versions of the Novell Client software and Novell NetWare server, and additional information on restrictions and stipulations when running MAS 90 in the Novell NetWare environment, see the Supported Platform Matrix located in the Support area of the Best Software Web site.
- Each workstation must recognize the network drive on which MAS 90 is loaded using a mapped drive letter. Using Universal Naming Convention (UNC) paths are not supported.

Example:

Correct  F:\Mas90\Home\Pvxwin32.exe...
Wrong  \\Servername\Sharename\Mas90\Home\Pvxwin32.exe...

If company data is moved to a different data location using Library Master Company Maintenance, the same drive letter must be used from all workstations to point to the alternate directories, including the server if it is used as a workstation.
Chapter 4

Consideration for Installing on a Windows NT/2000/2003 Server Network

The following are special considerations to be aware of before installing or upgrading MAS 90 on a Windows NT/2000/2003 network.

- Perform the CD installation on MAS 90 either directly at the server or from the workstation.

- When installing, close down all other visible desktop applications (for example, Microsoft Office applications). You should also shutdown some of the applications running in the system tray; however, you should not shutdown antivirus software unless it is actually interfering with the installation.

- At the server, create a share at a parent directory above the MAS90 folder. Do not create the share directly at the MAS90 folder. Every workstation will be required to map a drive to this share point.

- Each workstation must recognize the network drive on which MAS 90 is loaded using a mapped drive letter. Using Universal Naming Convention (UNC) paths are not supported.

Example

Correct  F:\Mas90\Home\Pvxwin32.exe...
Wrong  \Servername\Sharename\Mas90\Home\Pvxwin32.exe...

If company data is moved to a different data location using Library Master Company Maintenance, the same drive letter must be used from all workstations to point to the alternate directories, including the server if it is used as a workstation.

Make sure the drive mapping is created so it remains persistent after restarting the workstation. Generally this is accomplished either through a logon script or by selecting the Reconnect at Logon check box in the Map Network Drive interface at the workstation.

- For the hardware and service pack requirements for both the workstations and server, see the Supported Platform Matrix located in the Support area of the Best Software Web site.

Prior to beginning the installation process, see Pre-Installation Checklist on page 93.

At the share point, do not restrict the MAS 90 users beyond Change, Modify, or Full Control permissions.
Chapter 5

Consideration for Installing on a Windows Peer-to-Peer Network

The following are special considerations to be aware of before installing or upgrading MAS 90 on a Windows Peer-to-Peer network.

- Only the following operating systems are supported in a peer-to-peer configuration:
  - Windows 98 Second Edition
  - Windows 2000 Professional
  - Windows XP Professional Edition

- The server and all workstations must be using the same operating system. For example, if the server and three workstations use Windows XP Professional Edition but one additional workstation is running Windows 98 Second Edition, this configuration is not supported.

- When running with more than two users, the workstation acting as the server should be dedicated. Running MAS 90 on the server concurrently while other users are accessing MAS 90 from their own workstations may result in instability and performance issues.

- A maximum of five users is supported when running in the peer-to-peer environment.

- At the server, create a share at a parent directory above the MAS90 folder. Do not create the share directly at the MAS90 folder. Every workstation will be required to map a drive to this share point.

  If the server is running Windows 98 Second Edition, when creating the share, assign MAS 90 users Full permissions. Do not assign Read Only permissions as this will result in errors when starting MAS 90.

  If the server is running Windows XP Professional with NTFS file sharing and security or running Windows 2000 Professional, when creating the share, assign MAS 90 users Change or Modify or Full Control permissions. Not granting these permissions will result in errors while using MAS 90.

Prior to beginning the installation process, see Pre-Installation Checklist on page 93.
Chapter 5  Consideration for Installing on a Windows Peer-to-Peer Network

If the server is running Windows XP Professional Edition and has Simple File Sharing enabled, when creating the share, select the Allow Network Users to Change My Files check box. To verify if Simple File Sharing is enabled, select Start > My Computer. Then select Tools menu > Folder Options. Click the View tab and scroll to the bottom. Verify the Use Simple File Sharing (Recommended) check box is selected.

- Each workstation must recognize the network drive on which MAS 90 is loaded using a mapped drive letter. Using Universal Naming Convention (UNC) paths are not supported.

Example:

Correct  F:\Mas90\Home\Pvxwin32.exe...
Wrong  \Servername\Sharename\Mas90\Home\Pvxwin32.exe...

If company data is moved to a different data location using Library Master Company Maintenance, the same drive letter must be used from all workstations to point to the alternate directories, including the server if it is used as a workstation.

If you are using Windows 98 Second Edition and need to use the same drive letter on the server as you do on the workstation because you have moved company data to an alternate location, use the SUBST command to emulate a drive mapping on the server. Windows 98 Second Edition does not support drive mappings to a computer's own share point. Do not use the SUBST command on the workstations; instead create a drive mapping to the share point on the server. Also, be sure the drive mapping is created so it remains persistent after restarting the workstation.

If you are using Windows 2000 Professional or Windows XP Professional and need to use the same drive letter on the server as you do on the workstation because you have moved company data to an alternate location, at the server create a drive mapping to the share point. Do not use the SUBST command.

- For the hardware and service pack requirements for both the workstations and server, see the Supported Platform Matrix located in the Support area of the Best Software Web site.
**Installing Crystal Reports**

**Crystal Reports Overview**

Crystal Reports is a powerful, graphics-oriented reporting program that allows users to customize their graphical forms. Crystal Reports is fully integrated with MAS 90. MAS 90 provides a number of customizable Crystal Reports forms as part of the standard installation. The Workstation Setup program for MAS 90 installs the standard Crystal Reports Run-Time Engine on each workstation allowing all users to view reports created through Crystal; however, to modify or customize the standard forms included with MAS 90, or to create your own reports, you must install the Crystal Reports Design Environment. This is provided on the separate Crystal Reports CD-ROM.

**Installing the Design Environment**

You can install Crystal Reports in a number of different configurations. For information on the various options and configurations available, refer to the Crystal Reports user's manual and online documentation. This section of the manual discusses the relevant options required to run in the MAS 90 environment.

Each user that will be designing, customizing, or modifying Crystal Reports will need to install the Crystal Reports CD-ROM on their local system.

*NOTE* For improved performance, users with enough spare hard drive space on their local workstations can load the complete version of Crystal Reports on their systems.

*If you are installing to the workstation* for the purposes of modifying or creating Crystal reports, you will need to install Crystal Reports and perform a Typical installation. The Typical installation uses pre-assigned settings. For more information, see Installing Crystal Reports to the Workstation on page 38.

*If you are installing Crystal Reports to the network server*, refer to the Install PDF file located at the root Crystal Reports CD-ROM.
Chapter 6  Installing Crystal Reports

Installing Crystal Reports to the Workstation

To install Crystal Reports to the workstation

1. Place the Crystal Reports for Best CD-ROM in the CD-ROM drive.

2. If Autorun is enabled on the workstation, the splash screen appears; otherwise, on the Start menu, click Run and type D:\Start.exe, where D:\ is the CD-ROM drive. Click Install Crystal Reports.

3. The Crystal Reports for Best Setup window appears. Click Next.

4. In the License Agreement dialog box, select the I accept the License Agreement option and click Next.
5. Click Browse to change the installation path. Select the Typical option and click Next.

6. Click Next to begin the installation process.
Chapter 6  Installing Crystal Reports

7 A progress meter appears while the installation is in progress. When the installation is complete, the following window appears. Click Finish to exit.
Chapter 7

Installing the PCCharge Payment Server

PCCharge Payment Server

MAS 90 integrates with the PCCharge Payment Server to provide validation and authorization of credit cards through modules such as Accounts Receivable, Sales Order, and e-Business Manager. The PCCharge Payment Server works with a number of popular merchant accounts.

Installing the Payment Server

Installation of the PCCharge Payment Server is a multi-phase process.

To install the PCCharge Payment Server

1. Make sure you have all the information required to configure your PCCharge Payment Server before running the installation. Follow the instructions included in the PCCharge Payment Server online documentation.

2. Review the PCCharge Payment Server manual available on the PCCharge Payment Server CD-ROM. The manual is provided as a PDF file.

3. Install the PCCharge Payment Server. Select a server on your network that has a modem connection or access to the Internet. You will need to determine your hardware requirements based on which merchant you are using.

4. Contact GO Software Technical Support to activate your PCCharge Payment Server software (this information is also included in the PCCharge Payment Server online documentation). In the process, GO Software Technical Support will walk you through the initial configuration of PCCharge Payment Server and answer any questions you might have about the software and credit card processing.

NOTE
Most merchant accounts support modem connections but only a few support SSL through the Internet.
Chapter 7  Installing the PCCharge Payment Server

5  MAS 90 communicates with the PCCharge Payment Server via TCP/IP. This is not the default configuration. If you did not configure TCP/IP, perform steps 6 through 7.

6  To enable this configuration, you must enable TCP/IP support and establish a port on which the PCCharge Payment Server will be listening. Start the PCCharge Payment Server and click Preferences on the Setup menu. Click Advanced.

![Preferences dialog box](image)

- Secure Credit Card Numbers
- Do Not Accept Private Label Cards
- Require Duplicate Transactions to be Rejected
- Prompt to OPS 3000 Questions
- Notify When Contact Transactions are Due at Startup
- Magnetic Stripe Verification
- Decline Postscript when Not Equal to Printed Amount
The Advanced Configuration Setup window appears. Select the Use TCP/IP Connection check box in the TCP/IP Communications section.

The Local Port Number defaults to 31419. You can change this to any port number that is not currently in use on this workstation by another application. Do not use ports under 1024. These ports are reserved for common services (such as HTTP, SSL, and SMTP).

Consult your System Administrator to verify there are no port conflicts occurring on the machine to which you are installing the Payment Server. Write down the port number if you change it so that it can be recorded in MAS 90.

Configure the MAS 90 component so the applications can communicate with the PCCharge Payment Server.

The PCCharge Payment Server is not accessible from within MAS 90 until the Credit Card Processing module is registered. To enable the Credit Card Processing module, in the Library Master Company Maintenance window, click the Servers tab. If the Credit Card Processing module is not registered, the fields on the Server tab are not available.
Chapter 7  Installing the PCCharge Payment Server

Accessing the Payment Server Manual

The PCCharge Payment Server manual is available on the PCCharge Payment Server CD-ROM. If you do not have the Adobe Acrobat Reader installed on your workstation, you will need to install it before accessing the documentation. You cannot view the PCCharge Payment Server manual until the Acrobat Reader is installed.

To view the PCCharge Payment Server manual, open Windows Explorer and browse to the CD-ROM drive where the PCCharge Payment Server CD-ROM is located and double-click the DOCUMENTATION.PDF file.

Support and Upgrades

GO Software provides support for the PCCharge Payment Server product and can assist you with troubleshooting the setup, configuration, and continuing maintenance of the server. Contact GO Software if you are having problems receiving authorizations. For contact information, refer to the PCCharge Payment Server online documentation.
Performing System Startup

After installing MAS 90, you are ready to set up companies, security, and system preferences. Enabling security is not required; however, one company must be created before anyone can access the system.

MAS 90 offers a flexible security system that can be used to provide appropriate access to the system and to meet your company’s specific requirements. The security system can be simple or it can be elaborate, protecting various combinations of companies, modules, menus, tasks, and security permissions by creating multiple roles, and assigning these roles to users. Roles are assigned to users so that users are restricted to only those tasks that pertain to the roles they are assigned to. If the user attempts to access a secured area, access is denied.

When you installed the software, you either selected a standard security model for your system or no security. The standard security model requires users to log on to the software and allows you to define user roles that allow or restrict access to modules, tasks, and security events (such as creating a one-sided journal entry).

If you elected not to enable security during installation, you can do so at any time after installing the software. After security is enabled it cannot be disabled, although you can modify security preferences at any time from the Library Master module.

After installing the software, a program group is created (or a Start menu item under the Programs submenu is added). Click the MAS 90 icon in this program group to start the software.
Chapter 8  Performing System Startup

Starting the Software with No Security

If you selected the No security option during installation, after starting the software, the Manage Your System screen appears. Although you currently do not have security enabled, you can enable security by performing tasks from the Manage Your System screen.

If security is not enabled, users are not required to log on to the system, and all users in your system are assigned a default user and role. Default users have access to all modules and tasks except security events. If you elect not to enable security, you can modify the default user preferences, which apply to all users in your system. For more information, see Edit Default User Settings on page 47.

Security is not required but you must create and activate at least one company before you can access any module.

If security is not enabled, the Manage Your System screen appears for all users until the Don’t Show This Screen check box is selected.
You can perform the following tasks from the Manage Your System screen:

- Create and activate companies (see Creating and Activating Companies on page 50).
- Enable security by defining roles for your users, creating users, and assigning users to roles (see Setting Up Roles and Users for Security on page 68).

**Edit Default User Settings**

If you do not have security enabled, all users are assigned a Default user and role. You can edit the preferences for the Default user and role.

To edit the default user settings

1. Select Library Master Setup menu > System Configuration.
2. In the System Configuration window, click Dflt User. The User Maintenance window appears with the Preferences tab in view.
3. Modify the fields on the Preferences tab as needed and click Accept.

**NOTE**

You must create and activate at least one company before you can access any modules.

**NOTE**

The Preferences tab is the only tab you can access in User Maintenance if you do not have security enabled.
Chapter 8  Performing System Startup

Starting the Software with Standard Security

If you selected the Standard security option when installing the software, you are prompted to enter the Administrator password that you entered during the installation.

After entering your Administrator password, the Administrative Tools screen appears.

Logging on as Administrator does not automatically log you onto the software. Only certain Library Master tasks that must be performed from the Administrative Tools screen are accessible. To access the software, you must set up a user logon (other than the Administrator logon) and password in User Maintenance.

NOTE
When logged on as Administrator, you cannot access the Business Desktop and cannot print.
Performing Administrative Tasks

You can perform the following tasks from the Administrative Tools screen:

- Create and activate companies for new installations (see Creating and Activating Companies on page 50).
- Enable security by defining roles for your users, creating users, and assigning roles to users (see Setting Up Roles and Users for Security on page 68).
- Set up system preferences (see Setting System Preferences on page 79).
- Change your administrator password (see Changing Your Administrator Password on page 86).

If security is enabled, at least one company and one user must be created before you can access the system.
Creating and Activating Companies

You must create and activate the companies for which data will be processed. Many systems are set up with multiple companies to keep financial records for individual companies separate, and to separate real company data from test company data. Each company is identified using a three-character company code. Within the modules, you can set up data files for each company.

If you are creating companies that contain similar information, you can create companies from an existing company by copying information from the source company. For more information, see Copying a Company on page 53.

Company Activation

To create and activate a company

1. Use any of the following methods to open the Company Maintenance window:

   - In the Administrative Tools screen, click MAS 90 Company Maintenance.
   - In the Manage Your System screen, click Create and Manage Your MAS 90 Companies.
   - Select Library Master Main menu > Company Maintenance.
2 In the Company Maintenance window, enter a company code and company name.

3 Enter the fields appropriate to your company, including the Federal ID No. field.

4 Click Activate to activate one or more modules.

5 You are prompted to save the new company first. Click Yes.
6. In the Activate Module window, select the module(s) to activate and click Proceed. This process creates data files for each selected module for the company.

![Activate Module Window](image)

7. The Company Maintenance window appears again after the activation process is complete. Verify that the modules you selected to activate appear in the Activated Modules section of the window.

![Company Maintenance Window](image)

**NOTE**
The demo data company codes are automatically created and activated if they were selected during the installation process.
Copying a Company

You can create a new company from an existing company. You can copy company information including company forms, only company files, or only company forms from the source company.

To copy a company

1. Use any of the following methods to open the Company Maintenance window:
   - In the Administrative Tools screen, click MAS 90 Company Maintenance.
   - In the Manage Your System screen, click Create and Manage Your MAS 90 Companies.
   - Select Library Master Main menu > Company Maintenance.

2. In the Company Maintenance window, enter a company code and company name.

3. Click Copy.

**NOTE** Although you can define multiple company codes, you must define at least one company code before activating any modules.
4 In the Copy Data window, at the Source Company field, enter the company you are copying from.

5 Select whether you are copying all company information including company data and forms, only data, or only forms, and then click Proceed.

**Migrating Level 3.x Data**

If you are upgrading from MAS 90 Level 3.x, after you install the MAS 90 Setup program for new installations, you must migrate your Level 3.x data to the location of your Version 4 installation before it can be converted and ready to use. System data that can be migrated from Level 3.x includes company information, ZIP Codes, country codes, system preferences, and Customizer files.

To migrate your Level 3.x user logons, before running the Migrate Level 3.x Data wizard, you must have security enabled with one user set up. If security is enabled, you must have security access to the File Utilities security event in order to run the Migrate Level 3 Data wizard.
Verifying Data

The General Ledger module does not allow special characters to be entered as part of an account number, or as part of main accounts or segments. Special characters are defined as any value other than 0-9 and A-Z. This does not include the separator value.

Use the GL Level 3 Account Analysis utility to identify if there are missing records in Account Maintenance or special characters in general ledger accounts. The GL Level 3 Account Analysis utility can be downloaded from the Best Online Support and Services (BOSS) Web page of the Best Software Web site. For more information on how to prepare your data prior to migrating, refer to the GL4000-KBA on the Best Online Support and Services (BOSS) Web page.

Migrating Data

After running the GL Level 3 Account Analysis utility and correcting any records with missing records or special characters, you are ready to migrate your data. If the Migration wizard detects existing Level 3.x accounts with special characters, you will be prompted to exit the wizard and remove the special characters in existing account numbers. If you choose to continue with the migration, the company with the special characters will not migrate. Review the Migration Log for companies that did not migrate.
To migrate Level 3.x data

1. Select Library Master Utilities menu > Migrate Level 3 Data.

2. In the Migrate Level 3 Data Wizard Welcome window, click Next.

You will be prompted to close the Business Desktop. Click OK.
3 If you selected the Standard Security option during installation, type your Administrator password. Click Next.

This window does not appear if security is not enabled.
4. Enter the source directory of your existing Level 3.x data. The MAS90 directory must be included in the path. Click Next.
In the Migrate System Files window, select Yes to migrate your system files. System files include user logons, company information, ZIP Codes, country codes, system preferences, and Customizer files. Click Next.

If you are remigrating data, remigrating system files will delete most existing system files and remigrate them from your Level 3.x system. Click Yes to remigrate the files.
The Migrate Companies window allows you to migrate companies that may already exist in Version 4. Select Yes to migrate your existing companies. The companies that already exist in Version 4 will appear on the Select Company page, allowing you to select them for migration. Select No if you are migrating for the first time. Click Next.

![Migrate Companies Window](image)
7 In the Migrate Reports window, decide if you want to migrate existing Level 3.x Crystal reports. If you migrate Crystal reports, they will need to be added to the Custom Reports menu using Library Master Report Manager.
If Visual Integrator jobs exist in your Level 3.x system, the Visual Integrator Job migration window appears.

![Visual Integrator Job migration window]

---

62 MAS 90 Installation and System Administrator's Guide
In the Select Company window, select one or more companies to migrate. If you selected No on the previous Migrate Companies window, companies that exist in Level 3.x but do not exist in Version 4 appear. Verify that you have available disk space for the migration and click Next.
10 In the View Migration Information window, verify all your migration settings and click Next to begin the migration process.
Before clicking Finish, select the Display Migration Log and Display System Conversion Log check boxes to display a log of the files that are migrated. The logs appear in your default text editor (such as Notepad) after clicking Finish. The Migration Log is located in the Migration directory under the MAS90 directory.

11

The Migration wizard has copied your Level 3.x data to your Version 4 installation directory. Now you must convert your data to the current level. For more information, see Converting Data Files to the Current Level on page 66.
Chapter 8 Performing System Startup

Converting Data Files to the Current Level

If you are upgrading your system from Level 3.x and have migrated your system files using the Migrate Level 3 Data wizard, you must now convert the migrated data to the current level using Company Maintenance.

Data files for all modules are converted for the selected company and are placed in the following directory:

C:\Program Files\Best\MAS 90\Version4\MAS90\MAS_XXX (where XXX is the company code)

Convert Data Files

To convert data files to the current level

1. Use any of the following methods to open the Company Maintenance window:
   - In the Administrative Tools screen, click MAS 90 Company Maintenance.
   - In the Manage Your System screen, click Create and Manage Your MAS 90 Companies.
   - Select Library Master Main menu > Company Maintenance.
2 In the Company Maintenance window, at the Company Code field, enter a company code, or click the Lookup button to select a company to convert data files for. Only companies that have been migrated appear in the Company List window.

3 Click Convert.

4 In the Convert Module Data Files window, click Proceed.

5 The data conversion complete message displays. Click OK.

Data for the selected company has been converted to the current level. Repeat this procedure to convert data for other companies.
Setting Up Roles and Users for Security

To implement effective security, you must define roles for your system, and then create user codes and assign users to specific roles.

The security for MAS 90 is role-based. Roles should be set up to reflect the functional roles of your organization. You should define roles with access to certain modules, tasks, and security events that allow users to perform tasks related to their jobs. Roles are company independent, though you can assign roles to users who are restricted from entering certain companies.

Security is not required; however, a Default role is included in MAS 90 for all users. Users assigned to the Default role have access to all modules except security events. The Default role cannot be modified.

When establishing your system's security, use the concept of roles to identify the specific tasks and options you want users to be able to access. Users can be assigned to multiple roles so design your roles to be as granular as you like. Role permissions are cumulative, which means if a user is assigned to two roles where one role gives the user access to a program while another role does not, the user will be granted access to this program.

You must determine the requirements for your security system. In most cases, it is better to start with a simple arrangement. As more sophistication is needed, this flexible system can be refined easily.

Defining Roles

Roles are set up to reflect the functional roles within an organization. These roles are global to the software and are company independent. Permissions assigned to roles allow assigned users access to the areas of the software they need to perform their job functions.

For the General Ledger, Library Master, and Customizer modules, security can be further refined by assigning Create, Modify, Remove, or View permissions to maintenance tasks, or by setting Update or Print Only permissions to update tasks. For setup tasks, permissions can be set to Modify or View. Additionally, some module options, such as allowing batches to be merged can be allowed or restricted.
Defining roles is considered the first step in enabling security for your system. Before you define roles in your system, determine the functional roles needed for your organization.

To define roles

1. Use any of the following methods to open the Role Maintenance window:
   - In the Administrative Tools screen, click Role Maintenance.
   - In the Manage Your System screen, click Create and Maintain User Roles.
   - Select Library Master Main menu > Role Maintenance.

2. In the Role Maintenance window, at the Role field, type the name of the role (for example, AP Clerk) and press the ENTER or TAB key.

3. At the Description field, type a description for the role (for example, Accounts Payable Clerk).

4. If you are creating a role from an existing role, click Copy Role; otherwise, skip to step 7.
5 In the Copy Role window, enter the name and description of the new role to create.

![Copy Role window](image)

6 Select the check boxes for copying menu tasks, security events, and module options permissions, then click Proceed.
On the Tasks tab, you can restrict access to modules, tasks, or security permissions within tasks.

- To expand each level, click the + graphic. To select all items in a level, select the check box next to the option.

- To refine the level of security to individual modules and tasks, select the check box next to the individual modules that you want to allow access to.

- You can further allow or restrict the level of access to tasks within a module by selecting or clearing the check boxes for tasks within modules.

- Within each task of the General Ledger, Library Master, and Customizer modules, you can further allow or restrict the levels of security for the role.
Chapter 8  Performing System Startup

8 On the Security Events tab, select the check boxes next to the module and security events that you want to assign to the role. For more information, see Role Maintenance in the Help system.

![Role Maintenance](image)

9 On the Module Options tab, select the check boxes next to the options for which you are allowing access to.

10 Click Accept and repeat this procedure for each role you want to define.

After defining all roles for the system, you can create users, and then assign these roles to users. For more information, see Creating Users and Assigning Roles on page 73.
Creating Users and Assigning Roles

Defining a user includes setting up a logon and password, assigning access to specific companies, and assigning a role or multiple roles to the user. Creating the first user logon and password restricts the entire system to only that individual who has a user logon and password.

A user account can be defined with an expiration date to lock the user out of the system after a certain amount of time. You can also define start and end dates for any role assigned to the user. This feature allows a user access to certain areas of the system and security events for the limited period of time.

Before you create user logons and passwords, decide whether your system will require a unified logon, or a MAS 90 logon for all users. For more information, see Requiring a Logon and Password on page 79.

To create a user and assign a role

1. Use any of the following methods to open the User Maintenance window:
   - In the Administrative Tools screen, click User Maintenance.
   - In the Manage Your System screen, click Define Users and Security Access.
   - Select Library Master Main menu > User Maintenance.
Chapter 8  Performing System Startup

2 In the User Maintenance window, enter the User Logon field. If you selected the Use Unified Logon check box in the System Configuration window, this field must match the Windows logon name for the user. For more information, see Requiring a Logon and Password on page 79.

3 Enter the First Name, Last Name, and User Code fields. The user code is only referenced in the software and is not used for logon purposes.

4 If the selected user will be performing group customizations in the Customizer module, enter the Customization Code field.

5 Enter the Expires field to lock the user account after a certain date. A user will not be able to access the system after the date entered.

Note
If you do not enter a password and have selected the Require all Users to Enter a Password check box, when logging on to the software, the user will be prompted to enter a password.

6 If you selected the Require all Users to Enter a Password check box in the System Configuration window, enter the Password and Confirm Password fields. For more information, see Requiring a Logon and Password on page 79.
7. Select the company and role to assign to the user. You can assign multiple companies and roles to the user.

8. Enter a Start Date and Expiration Date for each role to start and end for the selected company, if required.

9. Click the Preferences tab and select user-specific preferences for the user and click Accept. For more information, see Setting Additional User Preferences for Security on page 76.
Setting Additional User Preferences for Security

User preferences are preferences that apply to each user. You can set up additional security measures for individual users such as setting a workstation to automatically log off, and manually locking certain users out of the system.

For security purposes, a workstation can automatically log off if it is left unattended for a specified period of time. This feature ensures that workstations are not accidently left with the software running, allowing unauthorized users access to sensitive information.

The Automatic Logoff feature is not activated if the Business Desktop is the active window on your workstation. In addition, the Business Desktop does not automatically shut down any activity in process, such as an update or report, that is currently processing, or if the Business Desktop is idle within an option's window, such as a data entry or inquiry window.

Setting a Workstation to Automatically Log Off

To automatically log off a workstation

1. Use any of the following methods to open the User Maintenance window:
   - In the Administrative Tools screen, click User Maintenance.
   - In the Manage Your System screen, click Define Users and Security Access.
   - Select Library Master Main menu > User Maintenance.

2. Select a user at the User Logon field.
3 Click the Preferences tab and select the Automatic Logoff check box.

4 At the Automatic Logoff Delay in Minutes field, type the number of minutes that the system is to remain active before automatically logging off this workstation. The maximum amount of time that can be specified is 999 minutes.

5 Click Accept. After you save a user record, the dollar signs ($) in the Confirm Password field disappear.
Locking Users

Another security feature is the option to lock users out of the system. This procedure illustrates how to manually lock users out of the system. Users can also be locked out of the system if a number of incorrect logon attempts occurs, or if the expiration date for all users' roles has expired. This can be done using the System Configuration task.

To lock users out of the system

1. Use any of the following methods to open the User Maintenance window:
   - In the Administrative Tools screen, click User Maintenance.
   - In the Manage Your System screen, click Define Users and Security Access.
   - Select Library Master Main menu > User Maintenance.

2. Select a user at the User Logon field.

3. Select the User Account Locked check box and click Accept.
Setting System Preferences

The software is equipped with a number of features that can effectively keep unauthorized users from accessing programs and files. In addition to basic security features, additional measures can be taken to further secure your data. These additional measures include, requiring a logon and password, enabling intruder detection, and specifying lockout duration.

Requiring a Logon and Password

To further protect your system, you can require all users to have a logon and password. First decide if you will set up your users with a unified logon, or a MAS 90 logon. A unified logon allows MAS 90 to authenticate and use the Windows logon. If you implement a unified logon, users do not need to reenter a logon and password when accessing the software. You can, however, require that users enter their password before accessing the software. A MAS 90 logon is independent of the Windows logon, and will be required to enter the software.

When you set up a MAS 90 logon, you can enable intruder detection. Intruder detection locks a user out of the system when a certain number of logon attempts fails. This prevents unauthorized users from trying numerous passwords while attempting to access your system.
To require a unified logon

1 Use any of the following methods to open the System Configuration window:
   - In the Administrative Tools screen, click System Configuration.
   - Select Library Master Main menu > System Configuration.

2 In the System Configuration window, select the Use Unified Logon check box to enable a unified logon for each user.

3 Click Accept.
SETTING SYSTEM PREFERENCES
Requiring a Logon and Password

To require a MAS 90 logon

1. Use any of the following methods to open the System Configuration window:
   - In the Administrative Tools screen, click System Configuration.
   - Select Library Master Main menu > System Configuration.

2. In the System Configuration window, select the Require all Users to Enter a Password check box.

   ![System Configuration Window](image)

   If this check box is selected after user codes are set up without passwords, when a user accesses the software, a dialog box will prompt the user to define a password.

3. To require passwords that are at least eight characters in length, include both letters and numbers, and do not include repeating characters, select the Require all User Passwords to be System Defined Strong Passwords check box.

4. To include a minimum length on passwords, select the User Defined Passwords must be of Minimum Length check box, and type a minimum number of characters needed for passwords.

5. To require all users to change their password after a number of days, select the Force Password Change After a Set Number of Days check box, and type a number of days.
To enable intruder detection, select the Lockout User After a Set Number of Invalid Logon Attempts check box, and then type the number of attempts you will allow before a user is locked out of the system (cannot attempt to log on anymore).

To specify an optional lockout duration, select the Unlock User After a Set Number of Minutes Elapse from the Last Invalid Logon check box, and type the amount of time you want the lockout to be in effect. After the amount of time has passed, the user can attempt to access the system.

Click Accept.
Setting Accounting Date Preferences

Setting a Prompt for the Accounting Date

The software maintains personal preferences for each workstation. One of these preferences is to prompt for the accounting date the first time a user accesses a module for that day.

To set a prompt for the accounting date

1. Select Library Master Main menu > Company Maintenance.

2. On the Preferences tab, select the Prompt for Accounting Date check box.

3. Click Accept.

If a prompt for the accounting date is not set in Company Maintenance, the module defaults to the accounting date it was last set at on that workstation, unless the Auto Set Accounting Date from System Date check box is selected.
Chapter 8  Performing System Startup

Setting the Accounting Date from the System Date

The accounting date for all modules can be set from the workstation's system date for convenience and to ensure that users do not accidentally use an old accounting date.

To set the accounting date from the system date

1  Select Library Master Main menu > Company Maintenance.

2  On the Preferences tab, select the Auto Set Accounting Date from System Date check box.

3  Click Accept.
Restricting the Accounting Date to Current and One Future Period

When performing certain data entry and register printing functions, the accounting date is used as the default. When the posting date used for updates does not fall within the current and one future period for the module, the summarized totals for the current or future period will not match the transaction detail reports.

To prevent this problem, users with supervisor rights can restrict the accounting date to the current and one future period for the Accounts Payable, Accounts Receivable, Inventory Management, Job Cost, Purchase Order, and Sales Order modules.

To restrict the accounting date:

1. Select Library Master Main menu > Company Maintenance.

2. On the Preferences tab, select the Restrict Accounting Date to Current and One Future Period check box.

3. Click Accept.
Chapter 8  Performing System Startup

Changing Your Administrator Password

Changing your administrator password on a frequent basis is a good idea to protect your system from unauthorized users.

To change your administrator password

1  In the Administrative Tools screen, click Change Administrator Password.

2  In the MAS 90 Security Password window, enter the Password and Confirm Password fields and click OK.
Chapter 9

System Administrator Tasks

This chapter provides procedures for maintaining certain tasks that are performed by a system administrator.

Determining Who is Accessing the System/Modules

Use Master Console to display all currently logged on users. The Master Console includes data on each workstation, the module and task being accessed, and the accounting date for each user.

To determine who is accessing the system/modules

1. Use either of the following methods to open the Master Console window:
   - Select Library Master Main menu > Master Console.
   - Select File > Master Console.
   - On the Standard toolbar, click the Master Console button.

2. In the Master Console window, determine the module and task being accessed by viewing the Module column and the Program column.
Chapter 9  System Administrator Tasks

Creating Public Tasks

To access tasks quickly, you can organize them into groups in public task folders that all users can access. In addition to tasks, you can also add desktop shortcuts and external programs, such as Microsoft Word or Excel into a public task folder so that users can select and launch one of these programs without leaving the software.

Even though public task folders are accessible to all users, individual menu tasks within a task folder are still subject to the standard menu security system (if one has been set up). All company, module, menu, and task restrictions assigned to users override all task folder assignments.

To create a public task folder and public tasks

1. On the Business Desktop, click the My Tasks tab. Right-click the My Task area and select New > Public Folder.

2. Type a name for the public task folder and press ENTER.

3. Right-click the folder and select New > Task.

4. In the Browse dialog box, select the module, the menu, and then the menu task to add to the folder and click Open. The task is added to the public tasks folder.

5. To add more public tasks to this folder, repeat steps 3 and 4, as necessary.

6. To add an external program to the public tasks folder, right-click the public task folder and select New > Program.

---

**NOTE**

To create public tasks, the role assigned to your user code must have the Allow public tasks for editing security event turned on.
7 In the Browse dialog box, click the Folder button and select the external program, then click Open. The external program is added to the public task folder.

8 To add more external programs to this folder, repeat steps 6 and 7, as necessary.

9 You must exit the software and log back on for the new public folder to be accessible. You can access the public task folder from the My Tasks menu on the Modules Menu toolbar, or the My Tasks tab.

You can also delete existing public task folders, and modify existing tasks or program titles. You can create an unlimited number of public task folders, and each folder can contain any number of tasks and programs.
Modifying Company Preferences

For each company, you can set a preference to print a user logon on all reports, allow the company to be accessed externally, and change the location of the Payroll directory.

To modify company preferences

1. Use any of the following methods to open the Company Maintenance window:
   - In the Administrative Tools screen, click MAS 90 Company Maintenance.
   - In the Manage Your System screen, click Create and Manage Your MAS 90 Companies.
   - Select Library Master Main menu > Company Maintenance.

2. In the Company Maintenance window, click the Preferences tab.

3. To display the user logon of the user generating a report or listing on all reports, select the Print User Logon on Reports check box.
4 To allow the company to be accessed externally through the company's objects, such as VBScript, JavaScript, or other programs that are not based on MAS 90, select the Allow External Access check box.

5 To change the location of the Payroll directory for security reasons, click Change Data Location, and type the path of the new location. The data location is company-specific and not module-specific. The path must be appended with MAS_XXX, where XXX represents the company code.

6 Click Accept.

**Uninstalling Modules**

You can remove menu records and programs from the software for a specific module. Prior to removing modules, this utility will check to ensure there are no data files for that module. If data files exist, they can be deleted using the Delete feature in Company Maintenance.

The Custom Office module cannot be removed using Uninstall Modules. Removing this module will impact access to customized forms, user-defined fields (UDFs), and access to the Visual Postmaster module.

Removing the Visual Integrator (VI) module will remove the module from the Modules menu; however, the VI directory and two associated files, VI0PER and VI0XRF, will remain in the file structure. The VI0XRF file contains the definitions for the default VI perform logic and is a cross-referenced file that provides shared UDF access between Visual Integrator and Custom Office.

To uninstall a module

1 Use either of the following methods to open the System Configuration window:
   - In the Administrator Tools screen, click System Configuration.
   - Select Library Master Setup menu > System Configuration.

2 In the System Configuration window, click Uninstall.
3. In the Uninstall Modules window, select the module to uninstall and click Delete.
Appendix A

Checklists

Before beginning the installation, test and validate all the hardware and network configurations using this manual and the Supported Platform Matrix, which can be found in the Support area of the Best Software Web site. Also review the current support library for any pertinent information, particularly the Hot Pre-Installation Issues page on the Best Software Web site.

Pre-Installation Checklist

1. Read this document in its entirety.
2. Back up your current system and data files.
3. Verify that the packing list is available. The packing list contains serial number, customer number, user key, and product key information that is required to install MAS 90 for the correct number of users and to register the modules.
4. Verify that you have the required hardware configuration. For more information, see the Supported Platform Matrix in the Support area of the Best Software Web site.
5. Verify you have 150 MB of disk space available for System Setup and Library Master, plus an additional 15 to 25 MB for each module. An additional 400 MB of disk space is required to install the Crystal Reports Designer.
6. To successfully install MAS 90 on Novell NetWare servers, see Consideration for Installing on a Novell NetWare Network on page 31.
7. If you are installing the StarShip Link module, refer to the following PDF documents on the StarShip CD-ROM: MAS90_200.pdf and User's_Guide.pdf, for detailed instructions including how to set up the StarShip Server.

NOTE: For specific support on how to back up your data, refer to manuals for your backup software or contact the vendor from whom you purchased that product.
Appendix A  Checklists

8____ To use the Unified Logon feature, you must specify a share point or drive mapping to the server installation during Workstation Setup. The same path used by the ODBC driver is also used to validate the user logon. If the Use Unified Logon check box is selected in the Library Master System Configuration window, you must have a valid path specified or you will not have access to the software. If the Use Unified Logon check box is selected and the path is not specified, you will be prompted for a user account and password even if an NT logon account is provided.

9____ To optimize performance of the ACT! Link module, your ACT! database should reside on the same server as your MAS 90 files.

If this is your first time installing MAS 90

1____ For Visual PostMaster to work correctly, you must clear the Hide MS-DOS file extensions for file types that are registered check box in Windows Explorer.

2____ Crystal Reports must be installed on the computer from which modifications to forms and reports will be made. You can install Crystal Reports on up to five workstations. Review the Install.pdf document, which can be found on the Crystal Reports CD-ROM, prior to installing the software.

3____ When installing the Payroll module for the first time, you must also install the Tax Table Update (TTU). Failure to install the TTU will cause a FILE PRU.SOA NOT FOUND message to appear when Payroll is first set up for a company. If this condition is encountered, you must install the TTU.

4____ You can only run one version of Crystal Reports on your system.

If you are upgrading from Level 3.x of MAS 90

1____ All of your modules must be upgraded to the levels contained on the MAS 90 CD-ROM.

2____ Run the GL Level 3 Account Analysis utility from the Best Online Support and Services (BOSS) Web page of the Best Software Web site. For more information, see Verifying Data on page 55.
### PRE-INSTALLATION CHECKLIST

1. **You must perform a parallel upgrade.**

2. Verify that all data entry files have been updated and are empty before upgrading. Any data in the data entry files during the migration will be lost.

3. Print all customized form definitions, including your Accounts Payable 1099 forms, Sales Order shipping label forms, Payroll W-2 forms, and quarterly governmental reports. Default forms may be erased in the upgrade process.

4. If you have custom modifications to any of your modules, consult your Authorized Reseller or Master Developer prior to installing any software.

5. Rebuild all data files using the Rebuild Key Files and Rebuild Sort File utilities.

6. Print and update all journals and registers for each company code before proceeding with the installation.

7. Because sales tax may be recalculated during the conversion, print the following reports: Accounts Receivable Sales Tax Report, Accounts Receivable Repetitive Invoice Listing, Accounts Payable Repetitive Invoice Listing, Open Sales Order Report, and Open Purchase Order Report.

8. Confirm in Accounts Receivable Customer Maintenance that all customers that have tax exempt numbers have a sales tax code defined. If a sales tax code is not defined, the tax exempt number will be deleted during the upgrade.

9. If data exists in alternate directories, verify in Alternate Directory Maintenance that a UNC path exists for all alternate directories. If changes were made in Alternate Directory Maintenance, rebuild alternate directory pointers using the Library Master Repair menu.

Appendix A  Checklists

13. If you are upgrading from Level 3.61 or prior, print the Warehouse Grouping Maintenance Listing from your current installation prior to upgrading.

Post-Installation Checklist

1. From the Business Desktop Welcome page, access the What's New page to review new features available in the system.

2. If you are installing the software on a network or installing System Setup, Library Master, or Custom Office, you must run the Workstation Setup program on each workstation.

3. Because of the Version 4.0 retrofits made to all modules, except General Ledger, review the placement of all your user-defined fields.

4. To run MS Script links, you must have the Microsoft Windows Script Host processor on your system. For information on installing the MS Windows Script Host processor, refer to the Microsoft Download Center Web site.

5. If you have customized Advanced Lookup Engine (ALE) lookups, after installing a new version of the software and prior to accessing other modules, from the Library Master menu, select Utilities, then ALE Conversion Utility to convert your lookups.

6. If you scheduled automatic updates in Level 3.x, reset those updates by selecting Library Master Main menu > Automatic Update.

7. If you migrated data from your Level 3.x system, the entire user name was migrated to the Last Name field in the User Maintenance window. To use the First and Last Name functionality, modify each user name using User Maintenance.

8. If you had custom buttons on your Business Desktop in your Level 3.x system, you will need to re-create those buttons in Version 4.

9. If necessary, recreate Public and Private tasks.

10. If necessary, set up your Device Configurator printers.

NOTE: If you migrated Level 3.x user logons and passwords, these passwords were converted to uppercase letters; therefore, they must now be entered as uppercase letters.
11. If you are upgrading from a level prior to Level 3.5, if you modified list modes using the Library Master List Mode Master feature, you must use the User Lookup Wizard to re-create them. List Mode Master was replaced by the User Lookup Wizard. For more information, see User Lookup Wizard in your Library Master Help system.


13. Click Reset on your Accounts Payable 1099 forms and Payroll W2 forms to apply new format changes. Use the Forms layout printed during the Pre-installation process to reenter your modifications.

14. Print the following reports and compare them to the reports printed during the Pre-installation process: Accounts Receivable Sales Tax Report, Accounts Receivable Repetitive Invoice Listing, Accounts Payable Repetitive Invoice Listing, Open Sales Order Report, and Open Purchase Order Report.

15. Confirm in Accounts Receivable Customer Maintenance that all customers that have exemption numbers still have the exemption number defined.

16. If you include sales tax on purchase orders and want to enter default tax schedules for vendors, use Assign Vendor Schedules in Accounts Payable Utilities to set up tax schedules. If you do not use taxation for purchase orders, clear the Sales Tax Reporting check box in the Accounts Payable Options window.

17. Checks in the Payroll and Accounts Payable modules can now be printed in American National Standards Institute (ANSI) format. To print non-graphical checks in ANSI format, clear the Graphical Forms check box for Checks in the Setup Options window. In the Payroll module, select the Print in ANSI Format check box in the Check Printing window. In the Accounts Payable module, select the Print in ANSI Format check box in the Check Printing or Manual Check Printing window.

NOTE
Be sure to first print the check and compare your check stock. Make any needed adjustments.
Appendix A  Checklists

To print graphical checks in ANSI format, select the Graphical Forms check box for Checks in the Setup Options window. If you have a check form that was created prior to Level 3.70, you can reset the form so that the ANSI Check Amount field appears in the Field Description list on the Detail tab; however, clicking Reset on the Header tab resets all the settings on the form. Print the form layout first, in case changes need to be reentered. As an alternative to resetting the form, you can create a new form.

18___ When installing the Tax Table Update (TTU), all of your current state and federal tax tables are replaced with new tables unless you have specifically excluded a state tax table from the update by selecting the Exclude this Table from Tax Update check box in Tax Table Maintenance. Local tax information is not updated.

19___ After setting up Return Merchandise Authorization data files for the first time to a pre-existing MAS 90 installation, select RMA Utilities from the Return Merchandise Authorization Setup menu. Perform the Create Customer Invoice Search Records process to create customer invoice search records in the Return Merchandise Authorization module.

20___ If you are upgrading from a level prior to Level 3.70, the way that completions are handled has changed in the Work Order module. If you have existing work order completions prior to Level 3.70, see Costing Methods for Unit Cost of Completion Entry in the Help system to review examples of cost completion methods.

21___ The file structure for Warehouse Grouping Maintenance in the Material Requirements Planning module was modified in Level 3.70 to correct Material Requirements Planning generation problems that occurred from inconsistencies in the warehouse grouping data entry. Because changes to the Warehouse Grouping Maintenance file will be initialized if upgrading from Level 3.61 or prior to Level 3.70 or 3.71, the Warehouse Groupings must be reentered in Warehouse Grouping Maintenance after the Material Requirements Planning module has been upgraded.

22___ Update the customized forms by selecting the Update Customized Forms to Current Level option and clicking Next in the Customizer Utilities window.
23. If you have used Customizer to customize MAS 90, prior to accessing other modules, you must select the Update Customized Forms to Current Level option in the Customizer Utilities window to merge changes.

24. If you are upgrading Crystal Reports from a level prior to Level 3.30, you may need to re-create your existing reports and forms. You should always test your modified Crystal Reports and forms after upgrading. For more information, refer to the module's xxread.txt file found in the Data\xx\MAS90\SOA directory (where xx is the module abbreviation) on the MAS 90 or MAS 200 CD-ROM.

25. If you are upgrading from Level 3.41 or higher, use the Crystal Report Conversion Wizard to convert your Crystal reports and forms.

26. You can run only one version of Crystal Reports on your system. There are several template reports per module included.

Additional Crystal Report conversions are necessary if converting from a level prior to Level 3.6x (from Level 3.5x or lower) Bar Code, Purchase Order, and Sales Order module forms and reports that contain miscellaneous charge codes or miscellaneous item codes. In the Bar Code module, the following forms are affected: P/O Receivers, Sales Orders, and S/O Picking Sheets. In the Purchase Order module the following forms and reports are affected: Purchase Orders, Return Orders, Open P.O. By Item Report, and Open Purchase Order Report. In the Sales Order module, the following forms are affected: Sales Orders, Picking Sheets and Invoices.

Because the database has changed, the Credit Card Settlement Report needs to be re-created.

You must delete all occurrences of arwrwa1.rpt and arwrwb1.rpt from the ###-### and ###-xxx (where xxx is the company code) MAS90\Reports directory. The report will be automatically created the next time it is printed. If modifications were made to the report, the changes need to be reapplied.
After migrating your Crystal Reports from Level 3.x, you must add them to your Custom Reports menu using Report Manager.

Review the Crystal Reports FAQs in the Help system.

27 If you are upgrading from Level 3.x an did not migrate your Visual Integrator jobs using the Migrate Level 3 Data wizard, you can convert your old jobs using VIWUD1 by selecting File > Run.

28 If dictionary changes were made to any file used on an import created in the Visual Integrator module, these imports may need to be manually updated. Review the Release Notices to determine if dictionary changes have been made in the module. The Release Notices can be accessed by clicking the Release Notices link on the What's New page of the Business Desktop. Also review the appropriate file layout using the Technical Reference and Support Guide (TRSG) and the Data Dictionary Listing accessed from the Visual Integrator Main menu to verify that the imported field names are consistent with the new file layout. For more information, refer to the TRSG.

29 For Visual PostMaster to work correctly, you must clear the Hide MS-DOS file extensions for file types that are registered check box in Windows Explorer.

30 Export your Report Master reports from Level 3.x using Report Master Job Export. Import them into your Version 4 installation using Report Master Job Import. You must recompile all custom reports defined using Report Master. To recompile reports, access Report Master Maintenance and enter the report name. At the maintenance screen menu bar, type ~ (tilde). Answer Yes to the Do you wish to prepare this report? prompt to recompile. Repeat this procedure for each defined report. Changes have been made to Level 3 module data dictionaries. You may need to verify your reports after this update.
Appendix B

Converting MAS 90 Crystal Reports from a Prior Version

The MAS Crystal Report Conversion Wizard converts prior versions of MAS 90 Crystal Reports to the latest data dictionary revisions and Crystal Reports format.

NOTE
This wizard will run the first time you access a Crystal Report created using a level of MAS 90 prior to Version 4.0.

1. From the MAS90\Home directory, locate and double-click mascrcw.exe. Click Next. The MAS Crystal Report Conversion Wizard appears.

![MAS Crystal Report Conversion Wizard screen]

Welcome to the MAS Crystal Report Conversion Wizard
This wizard allows you to convert your MAS Crystal Reports to use the new MAS data dictionary. To continue this wizard, click Next.
Appendix B  Converting MAS 90 Crystal Reports from a Prior Version

2 In the Choose a Data Source window, click Configure.

3 The Providex 32-bit ODBC Setup window appears. At the Database Directory field, verify the directory path. Click OK.

4 Select the Logon tab. At the Company code field, type your company code in uppercase. Verify that the company selected has the appropriate modules installed. For example, do not convert Manufacturing Crystal Reports (W/O or B/M) for demo company code ABC. Those modules do not exist and the conversion will complete on the reports.
At the Default UserID field, type the user logon and at the Password field, type the password and click OK.

At the User ID and Password fields, type the same user logon and password that you typed in the ProvideX 32-bit ODBC Setup window. Click Next.
At the Reports Path field, enter the path, or click Browse and select the directory to search for reports that require conversion. All Crystal Reports that have been previously converted or Crystal Reports that contain the current MAS 90 version (for example, 4.00) as a keyword will not be selected for conversion.

Click Search to generate a list of reports. Click Cancel to stop the search. You can select individual or multiple reports within the listing to convert. Select the desired report, or press CTRL to make multiple selections. Click Select All to convert all reports within the listing. Click Clear to clear the listing. To complete the conversion, click Next.
Click Finish to initiate the conversion process; click Back to return to the previous wizard or screen; click Cancel to exit the wizard.

**NOTE**

If a field name used within the report or form no longer exists in the data source, it will be noted on the listing and removed from the report or form. If the removed field is contained in a formula, a Crystal Reports error in printing message will appear when printing.

Click Print to get a listing of the selected reports and the conversion status of each report. The listing prints to the default Windows printer.

Successfully converted reports generate an unconverted backup file in the same directory with a file extension of .rp_. If Status:Complete appears, the report is successfully converted. If Status:Failed appears, note the error message and verify that the company you are logged onto via ODBC contains application data files for the selected report. If the conversion wizard cannot convert that report, the report must be manually converted. If errors are encountered during the conversion, the wizard will skip the report and continue with the next selected report.
Overview of Application Startup

This appendix explains how to successfully upgrade from another business management system to MAS 90 for the following modules:

- Accounts Payable
- Accounts Receivable
- Bank Reconciliation
- Bar Code
- Bill of Materials
- e-Business Manager
- General Ledger
- Inventory Management
- Job Cost
- Magnetic Media Reporting
- Material Requirements Planning
- Payroll
- Purchase Order
- Sales Order
- Work Order

This appendix is organized alphabetically for ease of reference; however, the following is the recommended sequence for converting your existing business management system to MAS 90: General Ledger, Accounts Payable, Accounts Receivable, Bank Reconciliation, Inventory Management, Purchase Order, Sales Order, Payroll, Job Cost, Bill of Materials, Work Order, Material Requirements Planning, Bar Code, and e-Business Manager.

WARNING
After System Startup has begun, this process should not be interrupted! Any interruption may cause important information to be lost.
Appendix C  Overview of Application Startup

Accounts Payable

Data You Need

Before beginning Accounts Payable System Startup, have the following information assembled and available for use:

- Your General Ledger Chart of Accounts
- Your bank account number(s) for the checking accounts used by Accounts Payable
- A list of standard payment terms offered by your vendors
- A list of your vendors, including address and phone numbers
- A list of all unpaid invoices to be processed

To obtain correct information from your Accounts Payable module, you must first bring it up to date with your existing accounts payable system. This is true whether you are using a manual system or a different computerized accounts payable system.

Conversion Process

Complete the following process to ensure that your system is current. These steps should be performed after completing System Startup and after adding all of your account information to the Accounts Payable master file.

To convert your existing accounts payable system

1. Identify all unpaid invoices as of your last closed accounting period.

2. Prepare an adding machine tape totaling the invoices. This amount should equal the account balance for Accounts Payable in your general ledger.

3. Set the posting date to the last day of the last closed accounting period.
4 Using Invoice Data Entry, enter these invoices into the system. Enter the outstanding balance amount for each invoice as of the end of the last closed accounting period. During the distribution process, post the entire distribution balance to your Accounts Payable general ledger account number. This is done because you have already expensed these invoices in a previous accounting period, and to do so again would duplicate those expenses.

By posting to the Accounts Payable account, both a debit and an automatic credit are generated in the same amount to the Accounts Payable general ledger account; therefore, the two amounts offset each other and there is no effect on the general ledger. After the conversion process, you would not normally post to the Accounts Payable general ledger account number, but would post to individual general ledger accounts, as appropriate.

As an alternative to this procedure, clear the General Ledger check box in the Accounts Payable Options window. You can then distribute invoices to their respective accounts and no general ledger postings are made.

5 Print the Invoice Register. The total shown on the Invoice Register should equal the total on the adding machine tape prepared in step 2. If it does not, an error has been made. Check your adding machine tape and Invoice Register, return to Invoice Data Entry, and make any necessary corrections. Reprint the Invoice Register.

6 Update the invoices.

7 Print the Aged Invoice Report, available on the Accounts Payable Reports menu, and retain a copy of this report for your accounting files. Again, the total on this report should equal the adding machine tape total.

8 In the Period End Processing window, select the Full Period End Processing option to clear the month-to-date purchase fields affected by the conversion.

9 Reset the posting date to the first day of the current accounting period.

⚠️ WARNING
If you use this alternate procedure, select the General Ledger check box in the Accounts Payable Options window after the conversion process has completed and you have updated the Daily Transaction Register.
Appendix C  Overview of Application Startup

10 Using Invoice Data Entry, enter any invoices you have received since the last closed accounting period. (These invoices should not include any invoices entered in step 4.) Post the distribution balance of each invoice to its appropriate general ledger account (not to the Accounts Payable general ledger account number). Print the Invoice Register and update the invoices.

11 Prepare an adding machine tape totaling any checks you have written since your last closed accounting period.

12 Using Manual Check Entry, enter these checks (step 11) into the system. If the check paid an invoice previously entered (step 4 or 10), no general ledger distribution is required. Type the invoice number exactly as you did when you entered it in step 10. If the check paid an invoice that you did not previously enter, you must distribute it to the appropriate general ledger account(s).

13 Print the Manual Check Register. The total should equal the total of the adding machine tape in step 11. If it does not, return to Manual Check Entry, correct the necessary entries, and print the Manual Check Register. When the register total and the adding machine tape agree, update the manual checks.

14 Print the Aged Invoice Report and verify that all invoices paid by the manual checks recorded in step 12 are indicated as paid on the report.

You have now converted to the accounts payable system and are ready to begin using your Accounts Payable module.
Accounts Receivable

Data You Need

Before beginning Accounts Receivable System Startup, have the following information assembled and available for use:

- Your General Ledger Chart of Accounts
- A list of jurisdictions in which you sell and collect sales tax and their tax rates
- A list of standard payment terms offered to your customers
- A list of your customers, including addresses and phone numbers
- A list of all invoices to process
- A list of all payments to process

To obtain correct information from your Accounts Receivable module, you must first bring it up to date with your existing accounts receivable system. This is true whether you are using a manual system or a different computerized accounts receivable system.

Conversion Process

Complete the following process to ensure that your current accounting system is in balance. These steps should be performed after System Startup and after adding all your customers to the Customer master file.

If you maintain Accounts Receivable customers using a Balance Forward method, it is not necessary to enter each invoice. For balance forward customers, total all unpaid invoices for each aging category, and enter an invoice for each aging category for each customer. For more information, see Open Item and Balance Forward Billing Methods in the Help system.
Appendix C Overview of Application Startup

To convert your existing accounts receivable system:

1. Identify all unpaid invoices as of your last closed accounting period.

2. Prepare an adding machine tape totaling the invoices. This amount should equal the account balance for Accounts Receivable in your general ledger.

3. Set the posting date to the last closed accounting period.

4. Using Invoice Data Entry, enter the invoices using the original invoice dates. During the distribution process, **post the entire distribution balance to your Accounts Receivable general ledger account number**. These invoices are already posted in an accounting period, and to post them again would duplicate the postings.

   By posting to the Accounts Receivable general ledger account, both a credit and an automatic debit are generated in the same amount to the Accounts Receivable general ledger account. The two amounts offset each other and there is no effect on the general ledger.

   After the conversion process, you will not normally post to the Accounts Receivable general ledger account number, but will post to individual general ledger accounts, as appropriate.

   As an alternative to this procedure, in the Accounts Receivable Options window, clear the General Ledger check box. You can then distribute invoices to their respective accounts and no general ledger postings will occur.

5. Print the Sales Journal. The invoice total shown on the Sales Journal should equal the total on the adding machine tape prepared in step 2. If it does not, an error has been made. Check the adding machine tape and the Sales Journal, return to Invoice Data Entry, and make any necessary corrections. Print the Sales Journal.

6. Update the invoices.

7. Print the Aged Invoice Report and retain a copy of this report for your accounting files. The total on this report should equal the adding machine tape total.

---

**WARNING** If you use this alternate procedure, select the General Ledger check box in the Accounts Receivable Options window after the conversion process has completed and you have updated the Daily Transaction Register.
8 In the Period End Processing window, select the Full Period End Processing option to clear the month-to-date sales fields affected by the conversion.

9 Reset the posting date to the first day of the current accounting period.

10 Using Invoice Data Entry, enter any invoices billed since the last closed accounting period. (These invoices should not include any invoices entered in step 4.) Post the distribution balance of each invoice to its appropriate general ledger account (not to the Accounts Receivable general ledger account number). Print the Sales Journal and update the invoices.

11 Prepare an adding machine tape totaling any cash receipts you received since your last closed accounting period.

12 Using Cash Receipts Entry, enter these cash amounts. For the deposit amount, enter the adding machine tape total from step 11. If the checks entered represent payment for a previously issued invoice (step 4 or 10), no general ledger distribution is required. If any checks represent payment for an invoice not previously issued, you must distribute the amounts to the appropriate general ledger accounts.

13 Print the Cash Receipts Journal. The total should equal the adding machine tape total in step 11. If it does not, return to Cash Receipts Entry, correct the necessary entries, and print the Cash Receipts Journal. When the journal total and the adding machine tape agree, update the cash receipts.

14 Print the Aged Invoice Report and verify that all invoices that are paid by the cash receipts recorded in step 12 are indicated as "paid" on the report.

You have now converted the accounts receivable system and are ready to begin using your Accounts Receivable module.

**WARNING**

If the General Ledger check box is cleared in the Accounts Receivable Options window, select the General Ledger check box before proceeding with the update.
Appendix C  Overview of Application Startup

Bank Reconciliation

Conversion Process

To obtain correct information from your Bank Reconciliation module, you must first bring it up to date with your existing bank reconciliation system. This is true whether you are using a manual system or a different computerized bank reconciliation system.

To convert your existing bank reconciliation system

1. Verify that all modules being integrated with Bank Reconciliation are fully installed and operational before beginning System Startup.

2. Select the Bank Reconciliation check box in the General Ledger Options, Accounts Payable Options, Accounts Receivable Options, Client Write-Up Options, Payroll Options, Purchase Order Options, and Time and Billing Options windows, as appropriate.

3. Manually reconcile the last bank statement for each account that you want to use in your bank reconciliation system.

4. Perform all preliminary startup activities (define the files and set the accounting date using the ending date shown on your last reconciled bank statement).

5. Set up the Bank Code file using the ending bank balance from your last reconciled bank statement as a source for the bank account number and ending bank balance.

6. Enter all outstanding checks from your last reconciled bank statement, using Check, Deposit & Adjustment Entry. If checks are already being processed through the Accounts Payable, Client Write-Up, or Payroll module, these outstanding checks should be checks that were updated in the check update process, but are not shown on the last bank statement. On the Check tab, clear the Cleared check box when these checks are recorded.
7 Enter all outstanding deposits or adjustments (those not shown on the bank statement) in Check, Deposit & Adjustment Entry. If deposits are being processed through the Accounts Receivable, Time and Billing, or Client Write-Up module, these outstanding deposits should have been updated, but not shown, on the last bank statement. On the Check tab, clear the Cleared check box when these deposits and adjustments are recorded.

Print the Bank Reconciliation Register to verify the accuracy of the information entered. If the information on the register is correct, your bank reconciliation system is now ready to use.

**Bar Code**

**Data You Need**

Before beginning Bar Code System Startup, create and have available the directory names that will be used for importing files from the handheld computer.

**Bill of Materials**

**Data You Need**

Before beginning Bill of Materials System Startup, have the following information assembled and available for use:

- Your General Ledger Chart of Accounts
- A single-level bill of materials listing for all bills you want to maintain
- Any miscellaneous codes that you want to set up for overhead, labor, outside processing, etc.

To obtain correct information from your Bill of Materials module, you must first bring it up to date with your existing bill-processing system. This is true whether you are using a manual system or a different computerized Bill of Materials system.
Conversion Process

Complete the following process to ensure that your system is current. These steps should be performed after completing System Startup and after adding all of your bill information to the Bill master file.

To convert your existing Bill of Materials system

1. Prepare a list of existing bills from your manual or computerized system. Verify that the information is current.

2. Review the structure of the existing bills. When possible, employ the modular bill structure to save work and provide increased flexibility.

3. Enter the bills and complete the header information.

4. Enter the component items, miscellaneous codes, and comments for each bill. If your bills use bill options, examine the bills to verify that all options and any option interactions are taken into account.

5. Print a Single-Level Bill of Materials Report for all bills and verify the information against the listings provided in your old system. Print an Indented Bill of Materials Report and verify that the bill structure is correct and complete.

6. Print a Bill Validation Report. This report examines the entire Bill of Materials master file. Correct any inaccuracies and print this report again, if applicable.

You have now converted the bill of materials system and are ready to begin using your Bill of Materials module.
Data You Need

Before beginning e-Business Manager System Startup, have the following information assembled and available for use:

- The procedure, Install and Configure the e-Business Manager Module, from your e-Business Manager Installation Guide
- The IP address and port number for each of the three servers (IIS, SMTP, and Web Engine)
- A list of your item categories
- A list of user IDs and passwords to assign to Internet-enabled customers (for order only)
- A list of user ID e-mail addresses and the company to which each user is assigned

General Ledger

The General Ledger module includes a General Ledger Setup Wizard that you must perform to convert your existing companies and account structure.

The General Ledger Setup Wizard provides several pages of questions and options that aid you in quickly setting up the General Ledger module for new companies; you must complete this wizard and additional procedures before using the General Ledger module to process your daily transactions.
Inventory Management

Data You Need

Before beginning Inventory Management System Startup, have the following information assembled and available for use:

- Your General Ledger Chart of Accounts
- A list of all inventory items containing cost, price, on-hand quantity, warehouse location, reorder requirements, etc.
- Any shipping documents, receiving reports, open purchase orders, or adjustment vouchers that must still be processed

To obtain correct information from your Inventory Management module, you must first bring it up to date with your existing inventory system. This is true whether you are currently using a manual system or a different computerized inventory system.

Conversion Process

Complete the following process to ensure that your current accounting system is in balance. These steps should be performed after System Startup and after adding all your inventory items to the Inventory master file.

To convert your existing inventory system

1. Prepare a list of current on-hand quantities for all inventory items. You can use the balances as of your last closed inventory accounting period end, or you can perform a physical count.

2. In the Inventory Management Options window, at the Current Inventory Period field, select the previous period (the last closed period).

3. In the Inventory Management Options window, clear the General Ledger check box.

4. Set the posting date to the last day of the last closed accounting period.
5 In the Transaction Entry window, enter each item’s current on-hand quantity as a receipt by selecting Receipts at the Transaction Type field. You must enter the quantity on hand and the unit cost for each item.

You can use a single receipt reference for entering the on-hand quantities for all items, or items can be separated into any logical grouping and entered under different references.

6 Print the Transaction Journal and verify all information. If necessary, select Transaction Entry to make corrections.

7 When the register is correct, perform the Transaction Journal update.

8 In the Period End Processing window, select the Full Period End Processing option. The current period is set to the period in which you begin processing.

9 In the Inventory Management Options window, select the General Ledger check box.

10 Reset the posting date to the first day of the current accounting period.

11 Enter any sales, issues, receipts, etc., for the current accounting period to bring the inventory management system up to date. Use Transaction Entry to record the transactions.

You have now converted the inventory management system and are ready to begin routine processing activities.
Appendix C  Overview of Application Startup

Job Cost

Data You Need

Before beginning Job Cost System Startup, have the following information assembled and available for use:

- Your General Ledger Chart of Accounts
- Estimates or estimate worksheets
- Job contracts with all pertinent information
- Estimated price lists
- Standard cost code list
- Job types list
- Burden rate information
- Overhead rate information
- Invoices or billing documents that need to be processed

To obtain correct information from your Job Cost module, you must first bring it up to date with your existing job costing system. This is true whether you are using a manual system or a different computerized job costing system.

Conversion Process

Complete the following process to ensure your system is current. These steps should be performed after completing System Startup and adding all jobs, cost codes, and cost types to the Job Cost master file.

To ensure that all accounting modules integrated with Job Cost, including the Accounts Payable, Accounts Receivable, Payroll, and Purchase Order modules, do not "double post" transactions that have been entered as part of the conversion process, it is recommended that the conversion process be performed immediately after the completion of period-end processing for all integrated modules.
To convert from your existing job cost system

1 Prepare a list of job-to-date cost information, detailed by cost code and cost type, for each open job. You should use the information from your last closed accounting period. If you are changing the coding format of your cost code from your previous system, indicate the new cost codes to use for each entry.

2 In the Job Cost Options window, clear the Post to G/L for Direct Cost Transactions and Post to G/L for Billing & Cash Receipt Transactions check boxes. The job-to-date conversion information to be entered should not be posted to the general ledger.

3 Set the Job Cost accounting date to the last day of the last closed accounting period.

4 In Job Posting Entry, enter a separate batch of direct cost entries for each job. Enter a separate entry with the job-to-date units (quantity) and job-to-date cost for each cost code and/or cost type detail. If each job contains a large number of cost code and/or cost type detail, update each batch separately.

5 If the Accounts Receivable module is not integrated with Job Cost, use Job Posting Entry to enter billing and cash receipt transactions for each job up to the last closed accounting period. Do not enter any billing or cash receipts that should be recorded in the current accounting period.

6 If the Accounts Receivable module is integrated with Job Cost, use Job Billing Entry to enter all invoices that have been billed to outstanding jobs. Use Accounts Receivable Cash Receipts Entry to enter cash receipts for job invoices. If you are integrated with the General Ledger module, you must back out these general ledger postings generated for these transactions to prevent double posting of information previously recorded.

Additionally, if invoices relating to job billing are entered in the Accounts Receivable module before the installation of Job Cost, reverse these invoices using the Adjustment feature in the Accounts Receivable Invoice Data Entry window before recording the job invoices. This prevents doubling the invoice information in the Accounts Receivable module.
Appendix C  Overview of Application Startup

7  If Work-in-Process accounting is being used, the initial Job Billing entries generate postings to the General Ledger module that adjust the appropriate Work-in-Process accounts with the total accumulated costs for each job. You must back out these general ledger postings to prevent double posting of information previously recorded.

8  Print the Work in Process Report for all jobs, and check the job-to-date information printed. Print the Job Billing History Report to check the billing and cash receipt transactions. If any errors are found, use Job Posting Entry or Job Billing Data Entry to make corrections.

9  Perform full period-end processing to clear the period-to-date information affected by the conversion data.

10 Reset the accounting date to the first day of the current accounting period.

11 Enter cost and billing transactions for the current accounting period.

You have now converted to the job cost system and are ready to begin using your Job Cost module.

Magnetic Media Reporting

Data You Need

Before beginning Magnetic Media Reporting System Startup, have the following information assembled and available for use:

- The appropriate government forms and publications
- The Quarterly Tax Report printed from the Payroll module
- A Vendor Listing printed from the Accounts Payable module for which you have selected the Print 1099 Payment History check box in the Vendor Listing window
Material Requirements Planning

Data You Need

Before beginning Material Requirements Planning System Startup, have a list of available warehouses ready for use, and know whether each warehouse is a standard distribution/manufacturing warehouse or a distribution warehouse that will receive only transferred goods.

Payroll

Data You Need

Before beginning Payroll System Startup, have the following information assembled and available for use:

- Your General Ledger Chart of Accounts
- A list of the earnings and deductions used for payroll processing
- Employer federal, state, and local tax ID numbers for each tax jurisdiction in which your employees are paid
- Tax tables for the federal, state, and local tax jurisdictions in which your employees are paid
- A list of employees, complete with personal information and quarter-to-date and year-to-date earnings and deduction history

To obtain correct information from your payroll module, you must first bring it up to date with your existing payroll system. This is true whether you are using a manual system or a different computerized payroll system.

In compliance with federal and state tax reporting requirements, payroll systems operate on a calendar-year basis. In addition, as the year progresses, large quantities of quarter-to-date and year-to-date data are accumulated; therefore, the ideal time to convert from your existing payroll system to the Payroll module is on January 1; however, because this may not be possible for your company, guidelines for installing the Payroll module at different times during the year follow.
Appendix C  Overview of Application Startup

Converting at the Beginning of the Calendar Year

If you are installing the Payroll module at the beginning of the calendar year, enter your information into the module; however, make no entries at any quarter-to-date or year-to-date fields. These fields are maintained automatically as payroll is processed throughout the year. With these tasks completed, you can proceed directly to the year's first payroll cycle.

Converting in the Middle of the Calendar Year

To obtain correct year-end totals and proper tax calculations from your Payroll module, you must first bring it up to date with your current payroll totals, including quarter-to-date and year-to-date earnings and a record of vacation, sick leave, and benefit accrued hours. This is true whether your existing payroll system is manual or computerized.

To record year-to-date information

1. Perform the normal setup procedures, and enter all employee information into the system.

2. In the Payroll Options window, at the Current Quarter field, select the previous quarter.

3. In the Payroll Options window, clear the General Ledger check box. This ensures that no general ledger postings are made from the Payroll module. Because the prior quarter information should already be reflected in your general ledger balances, allowing the postings to update would result in duplicate postings.

4. Enter manual checks using Payroll Data Entry for each employee to record the year-to-date earnings and tax information. In the Pay Cycle window, verify the Manual Taxes check box is selected and the Print Checks check box is cleared. You can use the previous quarter number as the check number. Enter all earnings, deductions, and tax information using the year-to-date information from the end of the previous quarter.

If an employee has worked in more than one state, make sure the earnings information is entered separately for each state.
5 Print the Payroll Data Entry Audit Report and verify all information. If necessary, make any corrections using Payroll Data Entry.

6 Print the Check Register and perform the Check Register update.

7 In the Period End Processing window, select the Quarter End Processing option. The Current Quarter field in the Payroll Options window increments to the current quarter.

If you are converting your payroll at the beginning of the current quarter, proceed to step 12.

If you are converting in the middle of the quarter, you must record each check issued during the current quarter using the following procedure.

To record current quarter checks

8 Enter each check issued during the current quarter as a manual check in Payroll Data Entry (that is, in the Pay Cycle window, clear the Print Checks check box and select the Manual Taxes check box). Enter the earnings, deductions, and tax information exactly as written on the original checks. You can enter a combined total of the checks issued for each employee. This method, however, does not provide the full detail and complete audit trail facilitated by a detailed entry of each check.

9 Print the Payroll Data Entry Audit Report and verify the accuracy of all entries. If necessary, make any corrections using Payroll Data Entry and print the Payroll Data Entry Audit Report.

10 Print the Check Register and perform the Check Register update.

11 Print the Daily Transaction Register and perform the Daily Transaction Register update.

12 Print the Quarterly Tax Report and the Payroll Check History Report, and verify all employee information.

13 Print and verify the Benefits Register. If adjustments are necessary, access individual employee records in Employee Maintenance.

14 In the Payroll Options window, select the General Ledger check box. This allows all future payroll processing to post to the general ledger.
You have now converted the payroll system and are ready to begin routine processing activities.

**Purchase Order**

**Data You Need**

Before beginning Purchase Order System Startup, have the following information available for use:

- Your General Ledger Chart of Accounts
- A list of miscellaneous charges you commonly pay
- A list of vendor quantity discount rates you use for inventory items
- A list of all addresses to which you have orders shipped
- All open purchase orders and back orders
- All receipts, invoices, returns, and material requisitions as of your last closed accounting period

To obtain correct information from your Purchase Order module, you must first bring it up to date with your existing purchase order system. This is true whether you are currently using a manual system or a different computerized purchase order system.

**Conversion Process**

Complete the following process to ensure that your current accounting system is in balance. These steps should be performed after System Startup and after adding all of your purchase orders to the Purchase Order master file.
To convert your existing purchase order system

1. Gather all open purchase orders as of your last closed accounting period.

2. Prepare an adding machine tape totaling the orders.

3. Use Purchase Order Entry to enter the orders into the system. In the Default Values for Purchase Order Entry window, clear the Print Purchase Orders check box to prevent the conversion orders from being reprinted. Next, on the Purchase Order Entry Header tab, select Standard Order at the Order Type field and Open at the Order Status field for each order.

   Partially received or invoiced purchase orders cannot be processed using the system without double posting to the General Ledger and Inventory Management modules. These orders should be processed manually until they are completed. To enter these orders, you must enter only the unreceived balance on each order as the original order quantity. There are no such restrictions for outstanding orders that have not received any partial receipts or invoices against them.

4. Print the detail version of the Open Purchase Order Report for all order types and orders with an open status. The total on this report should equal the total on the adding machine tape you prepared in step 2. If the totals do not agree, return to Purchase Order Entry and make any necessary corrections and reprint the report as an audit record of your outstanding orders.

5. Record all receipts, invoices, returns, and material requisitions that you have received since the last closed accounting period to bring the system completely up to date.

You have now converted the purchase order system and are ready to begin using your Purchase Order module.
Appendix C  Overview of Application Startup

Sales Order

Data You Need

Before beginning Sales Order System Startup, have the following information assembled and available for use:

- Your General Ledger Chart of Accounts
- A list of standard miscellaneous charges and items used in your business
- A list of item part numbers sold by your business (if the Inventory Management module is not integrated with Sales Order)
- A list of your shipping rates
- All open orders and back orders
- A Customer Listing from your Accounts Receivable module
- An Inventory Item Listing from your Inventory Management module

To obtain correct information from your Sales Order module, you must first bring it up to date with your existing order processing system. This is true whether you are currently using a manual system or a different computerized sales order system.

Conversion Process

Complete the following process to ensure that your current accounting system is in balance. These steps should be performed after System Startup and after adding all your sales orders to the Sales Order master file.

First, enter any unpaid invoices, as of your last closed accounting period, into the Open Invoice file. This process is performed using the Accounts Receivable module. Second, use the Sales Order module to enter any open orders or back orders into the system.
To convert your existing sales order system

1. Identify all open orders as of your last closed accounting period.

2. Prepare an adding machine tape totaling the orders.

3. Using Sales Order Entry, enter these orders into the system. Use the "standard" order type for standard sales orders, and the "open" order status for open orders. When entering the Sales Order Entry default values, clear the Print Sales Orders and Print Pick Sheets check boxes, and enter 00 at the No. of Ship Labels field in the Default Values for Sales Order Entry dialog box to prevent these documents from being printed.

4. Identify all open back orders as of your last closed accounting period.

5. Prepare an adding machine tape totaling the back orders.

6. Using Sales Order Entry, enter these back orders into the system. Use the "back order" order type for back orders, and the "open" order status for open orders.

7. Print the detail version of the Open Sales Order Report for all order types and the "open" order status. The Open Order and Open Back Order field totals shown on this report should equal the totals on the adding machine tapes prepared in steps 2 and 5. If the totals do not agree, check your adding machine tapes and the Open Sales Order Report. Return to Sales Order Entry and make any necessary corrections, and then reprint the report as an audit record of your outstanding orders.

You have now converted to the sales order system and are ready to begin routine processing activities.
Appendix C  Overview of Application Startup

Work Order

Data You Need

Before beginning Work Order System Startup, have the following information assembled and available for use:

- Your General Ledger Chart of Accounts
- A list of work center locations, including the number of employees and number of standard hours available per week at each location
- A list of operations to be performed, including cost and overhead calculations and general ledger production cost accounts
- A list of employees (optional), including labor rates and social security numbers
- A list of labor crews (optional), including the employees in each crew
- A calendar of days when the entire shop is closed
- A calendar for each work center with exceptions to the shop calendar
- A list of tools to be used during operations (optional)

To obtain correct information from your Work Order module, you must first bring it up to date with your existing work order system. This is true whether you are currently using a manual system or a different computerized work order system.

Because the Inventory Management module is integrated with Work Order, it may be impractical to bring the system up to date and reconstruct the original material cost information that should have been recorded. If you have installed the Inventory Management module, it is difficult to record past material issue transactions for work orders without affecting the current inventory balances.
The easiest and most effective way to convert the Work Order module is to enter only new work orders into the system. Do not record any transactions related to preexisting work orders using the Work Order module. You can use the Inventory Management module or the Bill of Materials module to record issues and receipts related to these work orders. For labor and miscellaneous expenses, the general ledger can be adjusted directly using General Ledger General Journal Entry. If the duration of your work orders is short, you can quickly complete the conversion process after all of the preexisting work orders are completed.

**Conversion Process**

Complete the following process to ensure that your current accounting system is in balance. These steps should be performed after System Startup and after adding all of your work order information to the Work Order master file.

To convert your existing work order system

1. In the Work Order Options window, clear the General Ledger check box to prevent any postings being made to the general ledger while entering conversion information.

2. Enter all open work orders using Work Order Entry.

3. Enter all transactions recorded for open work orders using Work Order Transaction Entry. Material costs may not be the same as the original costs.

4. Print the Work Order Transaction Journal, and perform the update.

5. Print the Open Work Order Report to verify the information recorded. If adjustments are necessary, repeat steps 3 and 4.

6. Print the Work in Process Recap report to verify the information recorded and to reconcile to the general ledger.
Appendix C  Overview of Application Startup

7  If you are entering material transactions for existing work orders, you can freeze inventory and perform a physical count and physical count entry without updating. Updating the Physical Count Variance Register should be performed only after all material issue transactions are recorded for existing work orders. Adjustments made during the Physical Count Variance Register update are recorded as physical adjustments in the Inventory Management Detail Transaction file. The Inventory Adjustment account in each item's product line is used to offset the Inventory account posting, unless the General Ledger check box is cleared in the Inventory Management Options window during the update process.

8  Perform the physical inventory process to update the quantity-on-hand information in inventory. This step should be performed after all material issue transactions have been recorded for open work orders.

You have now converted the work order system and are ready to begin using your Work Order module.
Index

A
accounting date
  restricting to current and one future period 85
  setting from system date 83
  setting prompt for 83
Accounts Payable
  conversion process 108
  data you need 108
Accounts Receivable
  conversion process 111
  data you need 111
activating a company 50
adding, public tasks 88
administrative tasks, performing 49

B
Bank Reconciliation, conversion process 114
Bar Code, data you need 115
Bill of Materials
  conversion process 116
  data you need 115

C
CD installation, System Setup 5
checklists
  post-installation 96
  pre-installation 99
companies, migrating 60
company
  activating 50
  coping 53
  creating 50
  modifying preferences 90
converting data files 66
converting to a MAS 90 system 107
Accounts Payable
  conversion process 108
  data you need 108
Accounts Receivable
  conversion process 111
  data you need 111
Bank Reconciliation, conversion process 114
Bar Code, data you need 115
converting to a MAS 90 system (continued)
  Bill of Materials
    conversion process 116
    data you need 115
e-Business Manager, data you need 117
General Ledger, data you need 117
Inventory Management
  conversion process 118
  data you need 118
Job Cost
  conversion process 120
  data you need 120
Magnetic Media Reporting, data you need 122
Material Requirements Planning, data you need 123
Payroll
  converting beginning of calendar year 124
  converting middle calendar year 124
  data you need 123
Purchase Order
  conversion process 126
  data you need 126
Sales Order
  conversion process 128
  data you need 128
Work Order
  conversion process 131
  data you need 130
copy a company 53
creating
  companies 50
  public tasks 88
  user code 73
Crystal Reports
  converting 101
  installing 37
  migrating 61
  overview 37
customizing My Tasks 88
Index

D
Data Access Pack, Setup program 27
data files, converting 66
date
  accounting date from system 83
  prompt for 83
date, restricting accounting date 85
default user settings, no security 47
defining System Security 68
DOS environment, installing 3

E
e-Business Manager, data you need 117
editing default user settings 47
enabling intruder detection 82

F
first-time installations, System Setup for 7

G
General Ledger
  data you need 117
  entering beginning balances 118
  graphic conventions 1

H
how to use this manual 1

I
installing
  Crystal Reports 37
  DOS environment 3
  from CD 5
  MAS 90 93
  Novell NetWare Network 31
  PCCharge Payment Server 41
  Windows 2000 Server 33
  Windows environment 3
  Windows NT Server 33
  Windows Peer-to-Peer Network 35
  Windows Server 2003 33
intruder detection, enabling 82

Inventory Management
  conversion process 118
  data you need 118

J
Job Cost
  conversion process 120
  data you need 120

L
Level 3.x data, migrating 54
lockout duration, specifying 82
logon, requiring 79

M
Magnetic 122
Magnetic Media Reporting, data you need 122
MAS 90, installing 93
Material Requirements Planning, data you need 123
migrating Level 3.x data
  companies 60
  Crystal Reports 61
  overview 54
  system files 59
  verifying 55
  Visual Integrator jobs 62
modifying company preferences 90
modules, uninstalling 91
My Tasks
  public tasks, creating 88

N
Novell NetWare Network, installing 31

O
overview
  Crystal Reports 37
  PCCharge Payment Server 41
### Index

#### P
- **Password**, requiring 79
- **Payroll**
  - converting beginning of calendar year 124
  - converting middle of calendar year 124
  - data you need 123
- **PCCharge Payment Server**
  - installing 41
  - manual, accessing 44
  - overview 41
  - support 44
  - upgrades 44
- performing, system startup 45
- post-installation checklist 96
- pre-installation checklist 93
  - installing for the first time 94
- prompt for accounting date 83
- public tasks, creating 88

#### R
- **requiring a password** 79
- restricting accounting date 85

#### S
- **Sales Order**
  - conversion process 128
  - data you need 128
- **security**
  - accessing MAS 90 with 48
  - accessing MAS 90 without 46
  - administrative tasks 49
  - default user settings 47
- **security**, see System Security
- accounting date from system date 83
- prompt for accounting date 83
- **Supported Platform Matrix** 93
- **system files**, migrating 59

#### System Security
- **creating**
  - user code 73
  - intruder detection, enabling 82
  - lockout duration, specifying 82
- **overview** 68

#### System Setup CD installation 5

#### System Startup
- **converting to a MAS 90 system** 107
- **DOS environment** 3
- **first-time installations** 7
- **overview** 3
- **Windows environment** 3
- **system startup**, performing 45

#### T
- **Task Menu Maintenance** 88
- **tasks**, creating public 88

#### U
- **uninstalling modules** 91
- **upgrading from Level 3.x** 94
- **user code**
  - creating 73
  - enabling intruder detection 82

#### V
- **Visual Integrator jobs**, migrating 62

#### W
- **Windows 2000 Server**, installing 33
- **Windows environment**, installing 3
- **Windows NT Server**, installing 33
- **Windows Peer-to-Peer Network**, installing 35
- **Windows Server 2003**, installing 33
- **Work Order**
  - conversion process 131
  - data you need 130
- **Workstation Setup Program**
  - location 18
  - overview 18
  - running 18